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INTRODUCTION

Thank you for choosing this Icom product. This product is designed and built with Icom’ s state of the art technology
and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.

This instruction manual contains detailed instructions on how to configure your own remote control system.
Before reading this manual, read the RS-BA1 Preparations that comes with the RS-BA1 for details on how to install

the software.

IMPORTANT

PRECAUTIONS

READ THIS INSTRUCTION MANUAL CAREFULLY
before using the software.

SAVE THIS INSTRUCTION MANUAL. This

instruction manual contains important safety and
operating instructions for the RS-BA1.

NOTE: This instruction manual is based on lcom

Remote Utility Version 2.22 and RS-BA1 Version 2.60.
» The software cannot be used with Windows on ARM.

Icom is not responsible for the destruction, damage
to, or performance of any Icom or non-lcom
equipment, if the malfunction is because of:

» Force majeure, including, but not limited to, fires,
earthquakes, storms, floods, lightning, other
natural disasters, disturbances, riots, war, or
radioactive contamination.

» The use of Icom transceivers with any equipment
that is not manufactured or approved by Icom.

IMPORTANT! To remotely control radios using the
RS-BA1, BE SURE that you comply with any local
regulations.

The RS-BA1 is designed to remotely control
transceivers through a LAN port, wireless LAN, or
USB port (Type-B/Mini-B/Micro-B/Type-C).

Proper audio communication cannot be guaranteed if
you connect the Server PC to the transceiver’s ACC
socket, MIC connector, or S/PDIF jack.

Depending on your transceiver, a few functions or
modes cannot be used, or you will need to update the
transceiver’s firmware to operate a CW keyer, using
the RS-BA1 application.

Depending on the PC’s performance, OS, IP provider,
connection type, condition, speed, and so on, the
USB audio may be interrupted, or control by the PC
software may get delayed.

If the CPU has a heavy load, the USB audio is
easily interrupted. The settings of your audio player
application may be changed after connecting a
transceiver to the PC.

To operate your PC and peripheral devices, follow the
instructions provided in their manuals.

All copyrights associated with this manual and all
intellectual property rights associated with the
RS-BA1 application are held by Icom Inc.
Unauthorized reproduction or transmission of this
manual, or any part hereof, is prohibited.

The content of this manual, the software associated
with the RS-BA1, and the appearance of the RS-BA1
are all subject to change without notice.

Icom and the Icom logo are registered trademarks of Icom Incorporated (Japan) in Japan, the United States, the United Kingdom, Germany,

France, Spain, Russia, Australia, New Zealand, and/or other countries.

Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries.

Microsoft and Windows are trademarks of the Microsoft group of companies.
All other products or brands are registered trademarks or trademarks of their respective holders.



INTRODUCTION

FUNCTIONS AND FEATURES OF Adobe® Acrobat® Reader®

The following functions and features can be used with Adobe® Acrobat® Reader®.
®The screen may differ, depending on the Adobe® Acrobat® Reader® version.

* Keyword search

Click “Find” (Ctr|+F) File m View Sign Window Help * Find screen
or “Advanced Search” Hd Find
(Shift+Ctrl+F) in the Edit menu to
open the search screen.
This is convenient when Previous Next
searching for a particular word or 8 .
phrase in this manual. » Advanced search screen
®The menu screen may differ, @ B8 search - o x
depending on the Adobe® Sl ’ T
® .
Acrobat Reader® version. u C)\ Eind Ctrl+F Where would you like to search?
© In the current decument
Advanced Search Shift+Ctrl+F ) All PDF Documents in
= Search More Tools = My Dorvmens =
. . / What word or phrase would you like to search for?
Click to open the find or search Check Speling ,
screen or advanced search screen. st
Protection L O include Bookmarks
[ Include Comments
Accessibility 14 =
Preferences... Ctri+kK
* Printing out your desired pages. * Read Out Loud feature.
Click “Print” in the File menu, and then select the The Read Out Loud feature reads aloud the text in
paper size and page numbers you want to print. this PDF.
®The printing setup may differ, depending on the Refer to the Adobe® Acrobat® Reader® Help for the
printer. Refer to your printer’s instruction manual details.
for details. (This feature may not be usable, depending on your
®Select “A4” size to print out the page in the PC environment including the operating system.)
original manual size.
Rotate View 4
ﬁ Edit View Sign Window Help L
Page Mavigation 4
B Open... Ctrl+0O
Page Display 4
Create PDF Zoom '
Save As... Shift+Ctrl+5 Tools '
Save as Other E Show,/Hide 4
é; Request E-signatures D e ’
1 i
[ Share Fie Display Size 4
Close Fil Ctrl+W
—oerE " [@] Read Mode Ctri+H
Properties... Ctrl+D |:| Full Screen Mode Ctrl+L
E Print... Ctrl+P F;(? Tracker...
1 Read Out Loud ]




INTRODUCTION

COMPATIBLE TRANSCEIVERS

The RS-BA1 is compatible with Icom transceivers that input and output audio through a LAN port, wireless LAN, or
the USB port (Type-B/Mini-B/Micro-B/Type-C).

Connection type Compatible transceivers
I(_ﬁl:nzggivers with the IC-7851, IC-7850, IC-7800 (Firmware version 3.00 or later),
. IC-7700 (Firmware version 2.00 or later), IC-7610, IC-9700, IC-905
Server function)
Wireless LAN IC-705
USB port IC-7100, IC-7200, IC-7300, IC-7410, IC-7600, IC-7610, IC-7850, IC-7851, IC-9100,
P IC-9700, IC-705, 1C-905
NOTE:

* If your Ilcom transceiver does not have a LAN port, wireless LAN, or a USB port, you can remotely control the
transceiver with an RS-232C interface. However, RS-BA1 operation with transceivers that input or output audio
through the ACC socket, MIC connector, or S/P DIF jack cannot be guaranteed.

» Depending on your transceiver, some functions or operating modes cannot be used.

» Depending on your transceiver, a firmware update may be required to use the CW mode.

The following transceivers are compatible with the RS-BA1 Dualwatch function:
IC-7851, IC-7850 (Firmware version 1.30 or later)
IC-7610 (Firmware version 1.10 or later)



TABLE OF CONTENTS

1

BEFORE USING THE REMOTE CONTROL SYSTEM........coooiiceriereieneereeeesee e e ssse s see s e see s e s ms s e ennnens 1-1
I oA = 1| 7= o T PR 1-1
B Adjusting the level of YOUr QUdIO AEVICES .........uuiiiiiiiii i e e e e e e e e e e e e e e e e s e s snnannes 1-3
B TranSCeIVEr'S PreSEHINGS .......eiiiiiiiiiiii et e e e et e e s et e e e e ann b e e e e e ennbe e e e e anneeas 1-5
B Selecting @ conNECtioN MELNOT ..........ooiiiiiiiii e e e e e e e e e e e e nbee e e e ennreeaeeennseeas 1-7
CONFIGURING THE SYSTEM THROUGH A CABLE. ..........oeeeee e ceccemecrrrer s e sss s ssssssnn e e e s s e s s e 21
B Examples of the remote CONrol SYSTEM .......ooo i 2-1
B STEP 1. Select @ connection MEthO.........cccuiiiiiiiiiie bbb s 2-2
B STEP 2. Connecting the transceiver to the PC ... ... 2-3
B STEP 3. Setting the Remote ULt ... e e e e e e 2-7
B STEP 4. Starting the Remote control Operation .............ooooiiiiiiiiiic e a e 2-11
CONFIGURING THE SYSTEM THROUGH A LAN ... ieerieeeereieeee s e s s e s sesssms s see s e e s e s s snee s e ensnnnnes 3-1
B Examples of the remote CONIOl SYSTEM .......oiiiiiiiiie e e e e e e e e e e e e e e neeeas 3-1
B STEP 1. Settings on the Base Station ............ouuiiiiiiii e e e e e e e e e e sannenes 3-2

< A. When using a transceiver with the Server funCtioN.............cooviiii i 3-2

O B. When USING the SEIVEI PC ...ttt e e e e e e e e e e e e e s e sta e e e e e eeaaaeeeaaannnns 3-4
B STEP 2. Settings on the Remote PC’s Remote Utility application ..o 3-10
B STEP 3. Starting the Remote Control OPeration ..............ouoiiiiie i e 3-14
CONFIGURING THE SYSTEM THROUGH THE INTERNET ........ooiioiieiimrirreseesseesseesenresseesssssssee s e ssssssessnssneas 41
B Examples of the remote control system through the Internet.............o e 4-1
B About a public IP address and the Dynamic DNS SEIVICE ............cooiiiiiiiiiiiieieieee e 4-2

< To let PCs connect to the Base station using its public IP address.............cccveeeeiiiiiiiiiiiciieeee e 4-2

< To let PCs connect to the Base station using its domain name ..............cccceeeeeiie s 4-3
o] o 0] 411Vz= 1 [T IR PPTS 4-4
B STEP 1. Settings on the Base Station ............oo e e e e e e e e e 4-5

< A. When using a transceiver with the Server funCtion.......... ..o 4-5

O B. When uSiNg the SEIrVEr PC ...ttt ettt e e e e e e e e e e s e e aet e e e e e aaaeeeeaaaanns 4-7
B STEP 2. Settings on the Remote PC’s Remote Utility application ..o, 4-11
B STEP 3. Starting the Remote control Operation ... e 4-15



TABLE OF CONTENTS

5 ABOUT THE REMOTE UTILITY ..uuuciiiiiiiisasrissnressssssssssesssssssssss s s ssssassms s s sssssssms s sssnsssssmsssssssssssssssassssssssnssassnss 5-1
H Setting Your PC’S @NVIFONMENT. ... ettt e e oot e e e e e e e e e e e e e ann e e e e e eaaaaeeeeaaaannnnnes 5-1
B Transceiver ReGISIratioN ........oooii ettt e e e e e e e e e e e e e e e aeaeeeeeeeeeaesasenennnnnnnn 5-2

o N [o [ TaTo = T (=T T Tod T Y P PPRUURRE 5-2
<& Changing @ transSCeIVEI'S PrOPEITIES.......ccccuuiiiiieiee e e e et e e e e e e e e e e e e e e e e e e eesseanasbssaeeeeaeeessaannnns 5-3
O DEIEtiNgG @ trANSCEIVET ...ttt e e ettt e e e e e e e e e s e st e e teeeeeaeeesaesasnsssbaeareeaaaaeeeaaaannns 5-3
< Adding a user who can access the tranSCEIVET ...............uviiiiiiiiie e 5-4
B Server ReGISTIatiON..... ...t e et e e e e e e e e e e e e nneeas 5-7
o e [ [ aTo = TR T =T VT PP PPP 5-7
O Changing @ SEIVEI'S PrOPEILIES .......eiiiiiiieeiie ittt ettt e et e e s et e e s e b e e e e e e nb et e e e e b be e e e e anreeeeaannbeeeeeennnees 5-8
Q DEIELING @ SEIVET ...ttt e e ettt oo e bttt e e eaab et e e e e e nbe e e e e e aabbe e e e e anbe e e e e e annnee 5-8
IO =Yt il g o R (o J= TR 1Y o= SRS 5-9
O CONNECHNG £0 @ SEIVET ...ttt e et e e ettt e e e et ee e e e asteeeeeansbaeaeeeansteeeeeanteeeeeeannees 5-9
<O DiSCONNECHING fTOM @ SEIVET .....iiiiiiie ettt ettt e e e e e e e et e e e e et e e e e e ssbeeeesanseeeeeeannteeeeeeannees 5-9
O] o] =3 o] =YY 1 1] oo T SRR 5-10
B CONNECHING 10 @ trANSCEIVET......ciiiiiiiii ettt e et e e e e e e e e b e e e e s e b be e e e e aaneee 5-11
O CoNNECHING 10 @ trANSCEIVET ...ttt e e ea b e e s e nbbe e e e e ennees 5-11
O DiSCONNECHNG @ trANSCEIVET ...ttt e e ab e e e s e e e s e b be e e e e ennees 5-11
B Adjusting audio level using the Remote Utility application .............oooorririiicccc e, 5-12
< Adjusting received audio VOIUME ........oouuiiiiiiiiiecee e e e e e e e e e e e e s et aeaeeaaeeeeeeennnnes 5-12
< Adjusting transmit @UIO VOIUME ...t e e e e e e e e e e e ae e e e e e e e e e eeannes 5-12
B Recording and playback FUNCHON ... e 5-13
<O ReCOording reCeIVEA AUAIO .....cooiiiiiiiie et et e e ettt e e e e e b e e e e n e e e e e neee e e e ennees 5-13
< Playing back and transmitting an audio file ... 5-14
B Monitoring another users from the SErver PC...... ... e 5-15
B DiSCONNECHING @NOLNEI USEIS......cciiici e e et e e e e e e e e e et et e ettt eeeeeeeeeta b aaaaseeeeeeeaaaaaaeeeeeeeeenesnnnnes 5-16

6 ABOUT THE REMOTE CONTROLLER...........iiiiiir e s s s s sn s s s emmn s mne s 6-1
B To use transmit audio iINPUL fromM the PC ...........oeiiii e e e e 6-2
Y oo 101 U= =0 Lo (= o o Lo [ USRS 6-2
B USING T RC-28...... ittt et ettt e e e e a bttt e e e e b bt e e e e ab b e e e e e enbbe e e e e e nbeeas 6-3

7 TROUBLESHOOTING......ccteiitiiiisisss s s ssss s s s sss s s s eas s s s s £ e e am e £ e e e £ e mE £ R aE S d e aE e R e aR e e e e e en R e s 71



OVERVIEW OF THE RS-BA1

» The RS-BA1 consists of the Remote Utility, used to configure a remote control system, and the Remote
Controller, used to send the CI-V commands to a Base station, to remotely operate it.
» With the RS-BA1, you can configure a remote control system through a LAN or the Internet.

About the Remote Control system
The RS-BA1 Remote Control system basically consists of the following 3 components:

(D Base station: Transceiver, or Transceiver and Server PC*
(2 Network (LAN or Internet)
(3 Remote station: PC (Remote PC)

* If you use a transceiver that does not have the Server function, you have to connect a PC to the transceiver.
In the Remote Control system, you can transmit or receive the Cl-V commands, control commands to turn the

transceiver ON or OFF, or communication audio through the Remote Utility.
You can remotely control the base station by the Remote PC using the Remote Controller.

A. When using the transceiver with the Server function

¢,

Other station

1
1
1
1
1
1
1
1
1
! INTERNET or | LAN
1
1
1
1
1
1
1

(1 Base station @ Network (3 Remote station

LAN

Other station

vi



B 1 BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings

The Windows operating system includes a firewall setting standard. This is a security function that can prevent
improper access to your PC from the Internet. To let the Remote Utility work properly, add it as an exception in the
firewall.

Windows 11

1. Right-click the Windows icon, and then click 5. Click <Change settings>.
“Network Connections.” e —

4 <« System and Security > Windows Defender Firewall > Allowed apps v C Search Control Panel 0

Installed apps

Allow apps to communicate through Windows Defender Firewall

Power Options o add, change, or remove alowed opps and pons,cick Change seltings .
Event Viewer - Ic

Allowed apps and features:

System Name Prvate  Public
P - e e |
Device Manager = —

Click <Allow another app...>.

B Alowed 3905 - o x

isk Manageme:

Shut’

| < System and Secuiy > Windows DefenderFrewal > Alowed 3pps . G| senConolrne £

Desktop

icate through Windows Defender Firewall
4 apps and ports, cick Change settings

© Right-click

2. Click “Advanced network settings.” -

ganappto ate & Change setting

BEE
o)
SIS

Settings ]

=]
Detas.. | Remove
S = Network & internet Click

Find a set S Ethernet
-_ ® Connected

System

ok Cancel

— * The “Add an app” screen is displayed.
7. Click “Remote Utility Software for Icom Radios”
S ® Efarumms ClICK : and then click <Add>.

@ Windows Update

Proxy
. Prony serverfor Wi-Fi and Eernet
K Accessibilty

2 Viewall network sdapters, network > Add an app x
Select the app you want to add, or ¢ - not
listed, and then dick OK. 0 c I H
ick
3. Click “Windows Firewall.” 7”
€ settings X Path: TS5 am Files (x36)\lco TylRe  Browse..
DY Advanced netWOl'k Settings What are the risks of unblocking an app?
WP Local Account You can cheose which netwerk types te add this apo to.
_\_/\_”'“)"\/_\/_\\ Network types e Click

_\_/\_/\/—\/—\

- * Returns to the “Allowed applications” screen.
e e Click . 8. In the “Allowed apps and features” list, confirm
Wi v e that “Remote Utility Software for Icom Radios” is

P displayed and a check mark is in the box, and

£ Gt then click <OK>.

18 Allowed apps - o X

4. Click “Allow an app through firewall.”

Windows Security

1| < system and Securiy > Windows DefenderFirewal > Alowed apps v o |socnconoipma o

Allow apps to communicate through Windows Defender Firewall
orremove allowe

) Firewall & network protection

Who and what can access your networks.

@ Home

O Protection history

Detais Remove

Allow anothes pp..

= @ Click

» The “Allowed applications” screen is displayed.

1-1



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings

Windows 10

1. Click the Windows icon, and then click the Setting 6. Click <Allow another app...>.
ICOﬂ P Allowed applications _ o

< ~ A @ < Windows Firewall » Allowed applications v @] | Search Control Panel »

Allow apps to communicate through Windows Firewall

= 2
To add, change or remove allowed apps and ports, click Change settings.
@ 9 Cllck What are the risks of allowing an app to communicate? &) Change settings
Allowed apps and features:
&)
O Click
ﬂ

2. Click “Network & Internet.”

Settings - o x

Windows Settings Detai Click

[ |
D @ oK Cancel

System Devices Phone Network & Internet
Display, notifications, Bluetooth, printers, mouse Link your Android, iPhone Wifi, fight mode, VPN

’ : » The “Add an app” screen is displayed.
Click 7. Click “Remote Utility Software for Icom Radios”

3. Click “Windows Firewall." and then click <Add>.

Mame. Private  Public ~

3]
]
Il

EOROREERIRAERA
OO ESREEE-
g0l EEEEE 0

Settings 5 x Add an app b
2 S Select the app that you want to add or dick Browse to find one that is not
Home tatus fisted and then dick OK.
| Find a setting » | Network status Applications: 0 C I ick
~— - ~— ﬁRamobe Utility Software for Icom Radios |

A Network troubleshooter

== & network problems.

u Click poperis
Windows Firewall ]
What are the risks of unblodking an app?

Network and Sharing Center

‘You can choose which network types to adc 9 CIICK

Network reset

Metwork types... Cancel

4. Click “Allow an app through the firewall.”

p——— —— * Returns to the “Allowed applications” screen.

4 Firewll & network protection 8. In the “Allowed apps and features” list, con_firm_
that “Remote Utility Software for Icom Radios” is

T~—— T T T displayed and a check mark is in the box, and

then click <OK>.

— . Temet troubleshooter
c I i ck tion settings
\gs

Restore firewalls to default

P Allowed applications — o

& v A <« Windows Firewsll » Allowed applications v | | Search Contral Panel p

» The “Allowed applications” screen is displayed. Allow apps to communicate through Windows Firewall
5- CI|Ck <Change Sett|ngs>_ To add, change or remove allowed apps and ports, click Change settings.

What are the risks of allowing an app to communicate? & Change settings

Allowed apps and features:

P Allowed applications - o X Name. Private  Public ~
m} u} a
« v o <« Windows Firewall > Allowed applications ~ Search Control Panel
4 PP ] e - o o
Confi 5 o
Allow apps to communicate through Windows Firewall Click © Confirm o o
To add, change or remove allowed apps and ports, click Change settings. — O [m]
e i soreroremaas
What are the risks of allowing an app to communicate? & Change settings.
= [u] [u]
Allowed apps and features: o o a
Name. Private  Public ~ o o o
a [m] a
a (| o o v
Details. Remove

Allow another app.

« | @ Click

1-2



1

BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

Before you start using the RS-BA1, the PC’s audio volume of your speakers or headsets must be set to a proper

level.

@ Information

* When several audio devices are used, you must individually set each one.
» Configurable items, displayed screens, and terms may differ, depending on your PC.

* These instructions are based on using Windows 11.

Other station

Settings for the Remote PC

(D Base station

Server PC

@ Network (3 Remote station

Adjust the volume level of the audio device that is connected to the PC.
* In the “Playback devices” menu, you can adjust the output level of the speaker or headset.
* In the “Recording devices” menu, you can adjust the modulation level sent to the transceiver.

Settings for the Server PC

Adjust the audio input and output level from or to your transceiver.

* In the “Playback devices” menu, you can adjust the modulation level sent to the transceiver.

* In the “Recording devices” menu, you can adjust the audio input level from the transceiver.
® Before adjusting, connect the transceiver and your PC, and turn ON the transceiver. (p. 2-2)

1. Right-click the speaker icon on the taskbar, then
click “Open Sound settings.”
® For the Windows 10, right-click the speaker icon on
the taskbar, then click “Open Sound settings.”

Troubleshoot sound problems.

&8 Open volume mixer

@ Click
~ % o[»] @ Right-click

» The “Sound” screen is displayed.
Click “More sound settings.”
® For the Windows 10, click “Sound Control Panel.”

System > Sound

& Privacy & securit fty

@ Windows Update More sound settings @

Related support

Click

& Helpith Sound A

Setting up a microphone

a

& Give feedback

Gethelp

3. Select the audio device that you use, then click
<Properties>.

? Sound

Playback Re o Click rcetins

Select a playback device below to modify its settings:

speak
Hig

‘ High Definition Audio Device
Ready

@ Select

I
—

Set Default 9 CIick

c

» The “Speaker Properties” screen is displayed.

» Continued on the next page.

1-3



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

4. Confirm “Use this device (enable)” is displayed in
the Device Usage menu on the <General> tab.

Bl Speakers Properties X

General || o CI|Ck ivanced  Spatial sound
jSpeakers]
QI Change lcon

- | @ confirm
—

5. Click the <Levels> tab.
Adjust the speaker’s audio level by moving the
slide control to the right or left.
@ If the mute setting is turned ON in “Speakers” ([{3]),
click the icon to turn it OFF.

Device usage: Use this device (enable)

1 Speakers Properties X
wel = | @ Click wemines
Speakers
i i 67 )| Balance 9 Adjust

6. After adjusting, click <OK> to close “Speaker
Properties.”

7. Click the <Recording> tab on the “Sound” screen.
In the list, select the audio device that you use,
and then click <Properties>.

9 Sound x
@ Click
Select a recording device below to modify its settings:
Microphone
High Definition Audio Device 9
@ Defautt Device Se|ect
- —
— gu
Configure Set Default

Cancel

Je Click

» The “Microphone Properties” screen is displayed.
8. Confirm “Use this device (enable)” is displayed in
the Device Usage menu on the <General> tab.

4 Microphone Properties b4

General | o Clic

JMicrophonc]

Change lcon

- | @ confirm
Cancel Aoply

Device usage: Use this device (enable]

1-4

9. Click the <Listen> tab.
If a check mark is inserted in “Listen to this
device,” click to remove it.

& Microphone Properties X

=] = ] @ Click

You can listen to a portable music player or other device through
this Microphone jack. If you connect a microphone, you may hear

i = O
@ Confirm

Default Playback Device ~

(CJiisten to this devicel

Flayback through this device:

10. Click the <Levels> tab.
Adjust the microphone’s audio level by moving the
slide control to the right or left.

@ If the mute setting is turned ON in “Microphone”
(), click the icon to turn OFF.

& Microphone Properties X

wwes ] == | @ Click

Microphone

8

® Adjust
'] 0.04dB

11. When connecting the transceiver to the PC with
a the USB cable, and when using the RS-BA1
Dualwatch function, click the <Advanced> tab
and then confirm the “Default Format” is set to 2
channel.

& Microphone Properties X

General Listen Leve\s o click

Default Format

Select the sample rate and bit depth to be used when running

in shared mode.
- | @ confirm

& channl, 16 bit, 44100 Hz (CD Quality)

Exclusive Mode

B Allow applications to take exclusive control of this device

8 Give exdusive mode applications priority

Restore Defaults

Creel | ooty

12. After adjusting, click <OK> to close “Microphone
Properties.”



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Transceiver’s presettings

The RS-BA1 remotely controls the transceivers using CI-V (lIcom Communication Interface-V) commands.
See the CI-V command table in the transceiver’s instruction manual for details of the functions that can be controlled.

The following manual settings are required when operating the RS-BA1

Properly preset the items in the table below for functions that cannot be controlled by CI-V commands, or for items
that may cause unintended actions. See the transceiver’s instruction manual for details of the settings or operation.

NOTE:

* Remove the transverter from the transceiver, if it is connected.

» To prevent an accidental transmission, we recommend you remove any key, keypad, or other external devices
connected to the transceiver.

» Set the transceiver to a normal operating mode. The transceiver cannot receive Cl-V commands in special
modes, such as the firmware update mode, clone mode, terminal mode, or access point mode.

* If the transceiver has the Time-Out Timer function, we recommend that you turn ON the function to prevent the
transceiver from continuously transmitting.

Genre Items Model Contents
RIT function Transceivers without the Server function | Set to OFF.
(Except for the IC-7100, IC-7300, IC-7600)
ATX function Transceivers without the Server function | Set to OFF.

(Except for the 1C-7300, IC-7600)

Simple band scope IC-746PRO*!, IC-7000*", IC-7100, | Set to OFF.
Function IC-7400*", IC-7410, 1C-9100,

SWR Measuring IC-746PRO*", IC-7000*", IC-7100, Set to OFF.

function IC-7400*", IC-7410, 1C-9100

Weather Alert function |IC-7100, IC-705 Set to OFF.

Timer/Sleep Timer Transceivers with the Timer function |Set to OFF.

function

RTTY decode screen

IC-746PRO*", IC-756PROIII*",

Close the screen.

Display IC-7400*
Volume for the RX All Set to a suitable level.
Volume .
audio
Cl-V Baud Rate All (Except for the IC-705, IC-905) 19200 bps (or “Auto”).
CI-V Address All Desired CI-V Address
@ If other devices are connected to the system,
BE SURE to not set a duplicate address.
Cl-V CI-V USB Port IC-7300%*2, IC-7610*2, IC-9700*2, Set to “Unlink from [REMOTE].”
IC-7850 (Firmware version 1.10 or later)*2,
IC-7851 (Firmware version 1.10 or later)*?
CI-V USB Baud Rate IC-7300*2, IC-7610*2, 1C-9700*2, Set to “115200” (or “Auto”).
IC-7850 (Firmware version 1.10 or later)*?,
IC-7851 (Firmware version 1.10 or later)*?
USB Serial Function Transceivers with a USB (Type-B) port | Set to “CI-V” for the selected
connection method.
Set mode

RS-232C Function

Transceivers with an RS-232C port

Set to “Cl-V” for the selected
connection method.

*1 Operations cannot be guaranteed.
*2 \When connecting to the USB port and using the Scope function.

NOTE: When using the IC-PW1, BE SURE to set CI-V Baud Rate to “19200 bps.” After changing the transceiver’s CI-V

settings, be sure to reset the CPU of the IC-PW1 and set the transceiver’s CI-V settings on the IC-PW1. See the IC-PW1
instruction manual for details.
When using the IC-PW2, BE SURE to set CI-V Baud Rate to “19200 bps.” See the IC-PW2 instruction manual for details.
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Transceiver’s presettings

The following settings are automatically set in the transceiver

When the Remote Controller connects to the transceiver, and you select the model name on the Connect Setting
screen, the following items are automatically set. If you manually operate the transceiver, set these items.

Genre Items Model Contents
MAIN/SUB Tranking IC-7610, Automatically set to OFF.
function IC-7850 (Firmware version 1.10 or later),
IC-7851 (Firmware version 1.10 or later)
SSB/CW Synchronous | All Automatically set to OFF.
Tuning
Calibration Marker Transceivers with the Calibration Automatically set to OFF.
Function Marker function
VOX function All Automatically set to OFF.
Scan function All Automatically cancels the scan.
RTTY filter IC-746PRO*", IC-756PROIII*", Automatically set to OFF.
IC-7400*"
Twin Peak Filter IC-746PRO*!, IC-756PROIII*", Automatically set to OFF.
IC-7400*"
Dualwatch function*2 IC-7600, IC-7800, IC-756PROIII*! Automatically set to OFF.
Display SUB band 1C-9100, IC-9700 Automatically set to OFF.
Memory channel/ All Automatically set to the VFO mode.
Call channel
, DR (D-STAR Repeater) |IC-7100, IC-9100, IC-9700, IC-705, |Automatically set to OFF.
Operating | 54 IC-905
Mode  Isatellite mode IC-9100, IC-9700 Automatically set to OFF.
Type of |DD (Digital Data) mode |1C-9700, IC-905 Automatically set to the FM mode.
emission | ATV (Amateur TV) mode | IC-905 Automatically set to the FM mode.
CI-V transceive All Automatically set to ON.
Cl-v CI-V 731 Mode IC-746PRO*", IC-756PROIII*", Automatically set to OFF.

IC-7400*"

*1 Operations cannot be guaranteed.
*2 The Dualwatch function is automatically set to OFF when using the Single mode screen
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Selecting a connection method

There are 3 connection methods. Select one from the following.

When you want to configure the system using a cable, see Section 2.

),

HNRRERERNANENN

When you want to configure the system using a LAN, see Section 3.
® When using a transceiver with the Server function, you do not need a Sever PC.

a N

RS-BA1

Transceiver
on the 2nd floor

Remote PC

\ onthe 1st ﬂoor<

RS-BA1

@Remote station

Base station

Transceiver
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B ” CONFIGURING THE SYSTEM THROUGH A CABLE

Examples of the remote control system

This section explains the minimum required settings to operate the transceiver through a cable, using the
following illustration as an example.

You can also refer to each application’s Help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the Help file.

RC-28
(Purchase separately)

|

Cable

Transceiver Remote PC

Name: IC-7300
CI-V address: 94h
Baudrate: 19200

TIP: If you use an RC-28 REMOTE ENCODER
connected to the Remote PC, you can use the
RS-BA1 and feel like you are operating the actual
transceiver’s MAIN dial.

21



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 1. Select a connection method

Check the connector type on your transceiver and see the following chart to connect your transceiver to the PC.

To connect an Icom CI-V command capable transceiver to the PC, you have to make connections for control

command and audio communication.

® The RS-BA1 operation with the PC connected to the transceiver’s ACC socket, MIC connector, or S/P DIF jack for audio
communication cannot be guaranteed.

Transceiver’s Outline Model Ref
connector Control command Audio )
Through a USB cable IC-7100, IC-7200, IC-7300, |p.2-3
IC-7410, IC-7600*",
[USB] port IC-7610, IC-7850, IC-7851,
IC-9100, IC-9700, IC-705,
IC-905
Through the CT-17 cI-v Through an audio cable All p. 2-4
LEVEL CONVERTER connected between the (Except for the IC-705, 1C-905)
[REMOTE] jack PC’s audio terminal and the
transceiver’s [ACC] socket
or [MIC] connector
Through an RS-232C Through an audio cable IC-7700*2, IC-7800*2 p. 2-5
cable connected between the
[RS-232C] PC’s audio terminal and the
connector transceiver’s [ACC] socket,
[MIC] connector, or
[S/P DIF] jack

*1 To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver's [REMOTE] jack.

*2 To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [REMOTE] jack or
directly connect to a LAN.

NOTE: About the USB connection
The USB driver shown below is required to use the RS-BA1.

Model Transceiver’s USB port type Install the driver in the:
IC-7100 Mini-B

IC-7200, 1C-7300, IC-7410,
IC-7600, IC-7610, IC-7850, | Type-B
IC-7851, 1C-9100, I1C-9700

IC-705 Micro-B
IC-905 Type-C

“Driver” > “CP210x” folder*

“Driver” > “lcom USB Serial Port Driver” folder

*When a PC with USB 3.0 port is used to operate the transceiver, confirm the driver name. If the name “Silicon
Laboratories CP210x USB to UART Bridge (Driver Removal)” is displayed on the Control Panel screen, uninstall
it and then install the latest driver.

Settings - o X

& Home Apps & features

Find a setting

talling apps

e Filter by: AT

Silicon Laboratories CP210x USB to UART Bridge
(Driver Removal)
Silicon Laboratories

Modify Uninstall
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CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [USB] port:

NOTE: For IC-7600 users
To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’'s [REMOTE] jack.

(p. 2-4)

1

System requirements

* APC that has a USB 1.1, 2.0, or 3.0 port

* Icom CI-V command capable transceiver that
has a [USB] port (Type-B/Mini-B/Micro-B/Type-C)

* The USB cable

Install a USB driver.

CAUTION: DO NOT connect the transceiver to
the PC with the USB cable until the USB driver
installation has been completed.

The driver is not supported by the Windows®
automatic recognition system.

To use the USB cable between the transceiver
and the PC, you must first install a USB driver.
The USB driver comes with the RS-BA1. You can
also download it from the lcom website.

The latest driver and installation guide can be
downloaded from here:
https://www.icomjapan.com/support/firmware_driver/
Read the installation guide before installing the
driver.

2-3

3

Connect the transceiver to the PC.

Connect the transceiver to the PC using the USB
cable.

This guide is based on using a Type-B USB
cable.

USB cable

To [USB]

Server PC

NOTE:

* If you connect a new USB audio device to
your PC, the device selected as the default on
your PC may be changed.

* DO NOT connect another transceiver using a
USB cable while the Remote Utility is open.
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CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [REMOTE] jack:

System requirements
* A PC that has an RS-232C connector
* Icom CI-V command capable transceiver that
has a [REMOTE] jack
* The optional CT-17 CI-vV LEVEL CONVERTER
® Mini-plug cables are included
* An RS-232C cable (Supplied with the CT-17)
+ Stereo audio cables (User supplied)

Connect a remote control system.
Connect the CT-17 to the PC, which enables the
CI-V communication between them.

Icom transceivers
mini-plug cable

S5

—=o__le=2

00,0BO)Ey l
99

© =
%F @ jé CcT17
To [RS-232C]
RS-232C cable
(Supplied with the CT-17) N
(
To [RS-232C]
9~15V DC

Server PC

NOTE: The CT-17 accepts only an RS-232C
cable. The use of an RS-232C-USB converter
is not guaranteed.

?m . .
5 9:0 892 9%09|  (Supplied with the CT-17)
= CE 080
=858 o>
IC3C == = = 0858
5 SF 2220 1ol
[%DDE O =0 D
jole |
Q.3 Q@
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Connecting an audio cables

Connect an audio cable between the PC’s audio
ports and the transceiver’s [ACC] socket or
[MIC] connector to enable audio communication

between them.
@® See the transceiver’s instruction
on the connector.

Transceiver
AF (Output)
MOD (Input) €

= LINE
LIN

e Connect to [ACC]
(Rear panel view)

Example: IC-7600 (8 pin)

e Connect to [MIC]

Example: IC-7600 (8 pin)
(Front panel view)

|
|
|
|
|
1
|
|
®® !
§555) |
EY . oo :_
|
|
|
|
|
|
|
|
|
|

+
MIC input —H—
"N\
@ GND 10pF/16V 1
@ ® :
Lo |

©®
©)
AF output ————— 1

Example: IC-7000
(Rear panel view)

manual for details

PC
IN/MIC IN (Input)
E OUT (Output)

Connect to
LINE IN

or

MIC IN

GND

&
Not used
AF

— —

- >

-

Server PC

-

Connect to
LINE OUT

GND

p
Not used
MOD

10uF/16V

= | .
il M
Y. ewmice +
®MIC input —EH
CAUTION:

* When using the [MIC] connector, DO NOT
directly connect an audio cable between the
transceiver’s Microphone input and PC. It

can cause a malfunction with

out adding the

Electrolytic capacitor, as illustrated above.
* DO NOT connect a monaural plug to the PC’s
LINE OUT. It can cause a malfunction.



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to a transceiver’s [RS-232C] connector:

NOTE: For IC-7800 or IC-7700 users
To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [REMOTE] jack or

directly connect to a LAN.

1 System requirements 2 Connect a remote control system.
* APC that has an RS-232C connector Connect an RS-232C cable between the
* Icom CI-V command capable transceiver that transceiver and the PC.

has an [RS-232C] connector

* An RS-232C cable (User supplied)

» Two S/P DIF digital cables or stereo audio
cables (User supplied)

To [RS-232C]

RS-232C cable
(User supplied)

To [RS-232C]

Server PC
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [RS-232C] port (Continued):

3 Connecting an audio cables
Connect an audio cable between the PC’s audio port and the transceiver’s [S/PDIF] jack, [ACC] socket, or
[MIC] connector to enable audio communication between them.
® See the transceiver’s instruction manual for details on the transceiver’s connector.

Using the [S/P DIF] jack Using other than the [S/PDIF] jack
Transceiver PC Transceiver PC
S/PDIF OUT > S/PDIF IN (Input) AF (Output) = LINE IN/MIC IN (Input)
(Output) MOD (Input) € LINE OUT (Output)

S/PDIF IN (Input) € S/PDIF OUT (Output)

Connect to
LINE IN

or

MIC IN

GND
e Connect to [ACC] &
(Rear panel view) Not used
AF ]

MOD
= GND
Optical cables }_, AF ———————— 4
(User supplied) 9 %}g !
Il— —T
|
| e
=—C[ 11+ —- e Connect to [MIC] !
— = 1+ (Front panel view) ! Server PC
+
MIC input —H—I

Server PC &%o—» GND  10uF/16V | | Connect to
@ 3) ! |LINE OUT
AF output el GND
Not used
MOD

CAUTION:

* When using the [MIC] connector, DO NOT
directly connect an audio cable between the
transceiver’s Microphone input and PC. It can
cause a malfunction without adding the Electrolytic
capacitor, as illustrated above.

* DO NOT connect a monaural plug to the PC’s LINE
OUT. It can cause a malfunction.
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

This section describes how to setup the PC.
® Before configuring the settings, turn ON the transceiver.

1 Open the Remote Utility.
1. Open “Icom Remote Utility.”
2. “Set your own PC information.” is displayed,

Remote Utility X

Set your own PC information.

then click <OK>. Click
® When you first open the Remote Utility, this
screen is displayed.
2 Configure the settings. - e
® When you first open the Remote Utility, this screen —
is dlsplayed ZCTWI: t (UDP) ® Enter
1. Enter a name for your PC of up to 16 etton ;W |
characters. (Example: Server PC) e | ®‘ Confirm
® DO NOT use the same name for more than one S ® Select
PC on your network. R @ Select
2. Confirm the port numbers of the Control, ®) Select
Serial and Audio ports. e
® Normally, use the default port numbers for
these ports.
3. Select the network connection type.
4. Select your Internet access line type. ez iy E3
5. Select the software display language. The changes il ffect fterthe appliction restars
® The selected language will be used as the Help
file language. ]
6. Click <Register> to save the settings. @ Click
7. Click <OK>, and then restart the Remote
Utility.
3 Click the Setup that you want to do. Setup Wizara T X
® If no servers or no radios are registered, this screen Clek the Setup that you want to do.
is displayed.
Click “Setup for a Local PC (Directly connect the _ _a » _@
radio and PC).”
(8 rado Vet S i) Comar g 3 S )
g Click
Setup for a Local PC Setup for a Server PC
{Directly connect the radio and PC) (The radio is accessible by Remote PC(s))
4 Start the Setup Wizard. Sctpatocl?C T
CIICk <NeXt>> Start the Setup Wizard

Setup alocal PC.

Register a Radio that is directly connected to the PC

To continue. click <Next:>

Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

Select a transceiver. Register s Radio ER
1. Select a transceiver that you want to add. o« A o b 6

(Example: USB)

[ the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click.

@ If the transceiver is not listed, click <Search>. e FC o e B e tham ekt Semre bt Y connected Watfor2 whle utl
@® Select “Manual” if the transceiver is connected ¥ the radia is corected to the PC using other than  USE cable. select from the radio from the [Manual]

drop-down list. Then click <Nesdt>

to the PC using other than a USB cable.
Select the connected transceiver from the drop-
down list. e @) select

2. Click <Next>>.
=L 1] @ Click

Set the CI-V/ICOM port settings. fessgiofada 2
1. Set the CI-V address, Baud rate, and COM e e e,
Port Number' « " I you want to change the CIV address and/or Baud rate, change from the lists below.
@ If you select “USB” in step 5, there are no T RS T e
necessary changes. )
2. Click <Next>>.

Search

& [ 1C-7300 coM=3 -

The COM port number is automatically set. ff they are no necessary changes, ick <Next>

Address |94
BaudRate |115200 « @ S t
COM Port Mumber |COM3

< Back

@ Click

TIP: When you select “Manual” in step 5 (e T %]
The Audio Settings screen is displayed. audo St
Select the devices that input a received audio from '
the transceiver and output a modulation signal to the o e e g o eostvd eudo fom he o nd ot modetento e o
transceiver, and then click <Next>>. [ s - |- () Select
[ Moo ouputpevice [hotuses =]z @ Select
™ Displays Virtual Device
[ | = || ® Click

7 Enter the radio name. Regicer a Radio 2

1. Enter the radio name. e —

® The model name and the last 5 digits of the o
serial number are entered by default. o s R e S i
2. Click <Next>>. e oo me R

Radorane [Crmo | @ Enter

@ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

The registration of the Radio is complete. Regitera Radio ?
Click <Finish>. Add Completed

The registration o the Radio is completed. To connectto the Radio, using the Radio List screen

Attention:

By connecting the Radia to a USB port, the defaut settings on the REC/PLAY device window may changs to
he Radio's Speaker and Microphone

Inthat case. no sound comes from the original speaker, or you cannot input aucio from the micraphone. To
corfim the seftings. dlick the <Sound Setfings> button below.

Or. f you use Dualwatch. make sure that the Microphone of the USB audio is set to 2 channels on the

Windows “Sound Settings” screen. f it is set to 1 channel, the receive audio forthe Sub band cannot be
output

Sound Settings

N
[ ok
d

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

A Sound x

Playback Fl:cording Sounds Communications

Select a playback device below to modify its settings:

Speakers
High Definition Audio Device
Default Device

Digital audio [5/PDIF)

| sl Hioh Definition Audio Device

A Sound x

Playbad| Recording So|lnds Communications

Select a recording device below to modify its settinas:

Microphone
High Definition Audio Device
Default Device

29



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

Connect the transceiver. [B com Remete usity = x
. File SetupWizard Options Help
1. Click <.Connect>. - _ _ _ R st | seve Lot
. T_he dialog that notifies the virtual serial port is D
displayed.

@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-2)
2. Click <OK>.
» “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

Settings Connect @ Click J MoD | Monitor | Delete

Remote Utility X

Serial port number is (3).

@ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 4. Starting the Remote control operation

This section describes how to connect and remotely control a transceiver from a PC using the Remote
Controller.
The description in this section is based on the assumption that:
* The transceiver is turned ON.
» The connection to the transceiver using the Remote Utility has succeeded.
(“<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Ver2.”
2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: 1IC-7300 (Ver1.42 -))
4. Select the connection between the transceiver and PC in Connection.
(Example: USB)
@ If the “MOD Select has also been changed.” dialog may be displayed. Click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: IC-7300 XXXXX)
» The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s Cl-V address, and baud rate.
@ If the desired transceiver is not displayed in Remote Ultility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < ﬂ > or “Exit” on the File menu.
® When the PC shuts down while the Remote Controller application is still running, the transceiver’s power may not
turn OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

[connect Setting x|

Madel
|\crauu[ven 42-) v| @ Select

Connection

uss =1| @ Select

| ©® select
Search
ClW

COM Port Baud ratelbps]
1500 - i

CI addiess CI¥ address
[Riacio) (RSBAT)

w
4

See the Audio Device (Yoice Memory)
HeIp file ICOM_VAUDIOA1 (lcom Vitusldud =

™ IEPWA or IC-Phw2 i connected,
[7 Controlled by older commands.
-

@ CI|Ck @.nllwalec\nsmgtulnsDFFlheF\adm |
@ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 4. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select a connector in MOD Select (Remote ON) (Example: USB), to input transmit audio from the PC to
the transceiver.

3. Click the close button to close the screen.

MIC SET > || ® Click
MOD Select
[Remate OM] @ Select
5B

MOD LEVEL

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
® To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the [F1] key on
your PC’s keyboard.

NOTE:
* DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
3. Turn OFF the transceiver and the PC.
® If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
» When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
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CONFIGURING THE SYSTEM THROUGH A LAN

Examples of the remote control system

This section explains the minimum required settings to configure a remote control system through a LAN,

using the following illustrations as examples.

® Only the Remote PC users whose ID and password are registered to the Base station transceiver or the Server
PC can connect to it. BE CAREFUL in managing IDs and passwords.

® You can also refer to each application’s Help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the Help file.

A. When using a transceiver with the Server function (p. 3-2)

E INTERNET
Base station transceiver
(Connect to wireless LAN)
Router

Connect to [LAN

Base station transceiver

Name: IC-7851abc
CI-V address: 8Eh

Baud rate: 19200

IP address:  192.168.0.10

B. When using the Server PC (p. 3-4)

RC-28
(Purchase

IP address: 192.168.0.1

INTERNET

Server PC

Name: Server PC
IP address: 192.168.0.10
Computer name: ServerPC

Transceiver

® The user ID, password, and other settings in these
illustrations are only examples. Configure the
system using your own settings.

separately)

|

Remote PC
Name: User PC
User ID: USER1

Password: USER0001

RC-28
(Purchase

Router
IP address: 192.168.0.1

3-1

separately)

|

Remote PC
Name: User PC
User ID: USER1

Password: USER0001

TIP: If you use an RC-28 REMOTE ENCODER
connected to the Remote PC, you can use the
RS-BA1 and feel like you are using the actual
transceiver’s MAIN dial.




3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function

Set each setting item on the Base station transceiver.
@ If you want to connect to the Internet and remotely control the transceiver, see Section 4.

NOTE: When you change a setting that displays “(Valid after Restart),” you must restart the transceiver after
setting. After restarting, keep the transceiver’s power ON or remain in the remote standby mode.

Network setting Transceiver registration
Items Contents Items Contents
DHCP* ON (Default) A Network Radio Name
Network Radio Name | ® Up to 16 characters
Network Name* A Network Name Example: IC-7851abc

Example: IC-7851

Network Control OFF (Default) — ON

Control Port (UDP) | 50001 (Default)

i Transmit audio setting
Serial Port (UDP) 50002 (Default) (For the IC-7800 and IC-7700)

Audio Port (UDP) 50003 (Default) Items Contents
:;‘:)Lg Internet access line Network MOD Use ON (Default)
Internet Access Line | Example: FTTH (Fiber To
The Home)
(Default)

* If you set DHCP to “OFF” to use the IP address
instead of the network name, or you use an 1C-7800
or IC-7700, set the items shown below.

Items Contents

An IP address that is not

assigned to any other device.

Example: 192.168.0.10
(Default)

IP Address

An IP address of the LAN
Default Gateway | side on the router
Example: 192.168.0.1
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function (Continued)

User registration

Items Contents

A User ID
® Up to 16 characters
Example: USER1

Network User1/2/3*
ID

A Password

® 8 ~ 16 characters

® At least 2 different
characters must be used.

Example: USER0001

NO (Default) — YES
® When the user is set as an
administrator.

Network User1/2/3*
Password

Network User1/2/3*
Administrator

* There is no User3 in the IC-7610, IC-9700, IC-705, and IC-905.

NOTE: To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters.

TIP: Standby mode setting

To remotely control the transceiver using the RS-BA1, the transceiver should be turned ON or be in the standby
mode.

To set the transceiver in the standby mode, set the item described below and select

“Standby (for Remote Control)” on the displayed screen when you turn OFF the transceiver.

® The [POWER] LED slowly blinks orange if the transceiver is in the standby mode.

Items Contents

Shutdown Function
(For the IC-7700, IC-7800, IC-7850, IC-7851)

Standby/Shutdown
Power OFF Setting (for Remote Control)

(For the IC-7610, 1C-9700, IC-705, IC-905)

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 3-10)
Confirm the transceiver settings described below.

* Network Name or IP Address

* Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode
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STEP 1. Settings on the Base station

CONFIGURING THE SYSTEM THROUGH A LAN

< B. When using the Server PC

Connect the transceiver to the Server PC and setup the Remote Utility.
® If you want to connect to the Internet and remotely control the transceiver, see Section 4.

1

Connect the transceiver to the Server PC.
Connect the transceiver to the Server PC with a
cable.

® See page 2-2 about the connection.

Open the Remote Utility.
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Ultility, this
screen is displayed.

Configure the settings.
® When you first open the Remote Ultility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: Server PC)
@® DO NOT use the same name for more than
one PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® You should use the default port numbers for
these ports.
Select the network connection type.
Select your internet access line type.
Select the software display language.
® The selected language will be used as the Help
file language.
6. Click <Register> to save the settings.
7. Click <OK>, and then restart the Remote Utility.

akrw

Click the Setup that you want to do.

® If no Servers and no transceivers are registered,
this screen is displayed.

Click “Setup for a Server PC (The radio is

accessible by Remote PC(s)).”

Start the Setup Wizard.
Click <Next>>.

34

Remote Utility x

Set your own PC information.

1 || click

Settings 7 x W
@ Enter

PC Name

Control Port (UDP) ‘ 50001 ‘

Serial Port (UDP) ’W @ conﬁrm
Audio Port (UDP) [s0005 |

@ Select
s @ Select
Language

® Select

Remote Utility X
The changes will be effect after the application restarts.
|
Setup Wizard ? X
Click the Setup that you want to do.
Setup for a Remote PC Setup for a Remote PC
(A radio with the Server function) (Connect through a Server PC)

- -

Setupfor a Server FC
(The radio is accessible by Remate PC(s))

=

Setupfor a Local PC
(Directly connect the radio and PC)

Click

Setup 2 Server PC ? X

Start the Setup Wizard

Setup a Server PC

Register a Radio that is directly connected to the PC to use remote operation from other PCs.

To cortinue, click <Next>




3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

Select a Radio for the Remote operation. Regfioiils 2
1. Select a transceiver that you want to add. e st s o
@ If the transceiver has already been regiStered’ Select [new] if you want to register a new radio that is accessible from ather PCs
select “Registered radios” and select it from the Orseectram [Resistered radiosl.

After selecting. click <Next>

drop-down list.
2. Click <Next>>.

* New

¢ Registered radios [select = radic =1

o] cliek

7 Selecting a Radio Registe a Radio D

Selecting a Radio

® If you select “Registered radios” in step 6, go to the Sotoct & R ot yut i 0 add
next page (step 9).

If the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click.

1. Select a connection type (Example: USB). e e O e e TR
@ If the transceivers are not listed, click <Search>. Kt i comnectdt the PC usg tferthan 2 USB cale,seict e rado fom o (orwal
« . . . rop-down list. Then click <Next>
® Select “Manual” if the transceiver is connected
to the PC using other than a USB cable. fum femw con-3 o | s |
H " Manual ither
Select the connected transceiver from the drop- " @ select

down list.

2. Click <Next>>. [ =o || @ Click

8 Set the CI-V/ICOM port settings. EmatrE o3

CIV/COM port Settings

® If you select “Registered radios” in step 6, go to the St the IC 73000 0 setings

next page (step 9).
If you want to change the CI-V address and/or Baud rate, change from the lists below.
1. Set the CI-V address, Baud Rate, and COM [T"a e
Port Number.
® If you select “USB” in step 5, there are no
necessary changes. e o4

2. Click <Next>>. ol (@ Set
COMPorthumber [coms -]

The COM port number s automaticaly set. I they are no necessary changes. dlick <Next>

@ Click
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STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

CONFIGURING THE SYSTEM THROUGH A LAN

When you select “Manual” in step 7:

The Audio Settings screen is displayed.

Select the devices that input a received audio from
the transceiver and output a modulation to the
transceiver, and then click <Next>>.

Register a Radio

Audio Settings
Set the audio of the Radic,

After selecting, click <Next>

Select the devices that input a received audio from the radio and output a modulation to the radio

AFInputDevie [N - | &@ Select

| MOD Qutput Device  [Not used

-I* @ Select

Device Options
Search

Iv Displays Detected Radia's Device

I Displays Virtual Device

9 Register a User to allow a connection.

1.

wn

No ok~

Click <Add>.
» The Add User screen is displayed.
Enter a User ID. (Example: USER1)

Enter a password of more than 8 characters.

(Example: USERO0001)
Click <OK>.

Select a registered user.
Click <Add >>>,

Click <Next >>.

NOTE: To prevent unauthorized access

Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers

or characters.

Register a Radio

Register a User to allow a connextion
Rlegister o User to allow a connection 1o 157300

can change this setting later.

Register a User to allow a connection. I no user s registered, ciick <Add> to register the Add User screen. You

Registered Users Accessible Users
Add>>
<<Delete
< Back Mext > Cancel

(Add User T

X

@ Enter P e—

3 Enter @ ain

(Example: ——

USER0001) @ C||Ck

To set the user as
an administrator,
click to put a
check mark.

A 4

Register a Radio

Register a User to allow a connection
Register a User to allow a connection to |C-7300

<<Delete

Register a Userto allow a connection. f no useris registered. cick <Add> to registerthe Add User screen, You

= ter,
@ Click @ Click ..u-
USERL (Admin) USERL (Admin

_cx | we || (D Click
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

10 Enter the radio name. SR o5
1. Enter the radio name. e e ot o G700
® The radio’s model name and the last 5 digits of o
the serial number is entered by default. [EE=E e
2. Click <NeXt>>, Click <Next> to register to the Radio

RadoMeme [1C73000 | @ Enter

@ Click

11 The registration of the Radio is completed.
Click <Finish>. Register a Radio 5

Add Completed

The registration of the Radio is completed. To connect to the Radio, using the Radio List soreen

Attention:

By connecting the Radiato a USB port, the defaut settings on the REC/PLAY device window may change to
the Radio’s Speaker and Microphone.

Inthat case. o sound comes from the original speaker. or you cannot input audio from the microphone. To
confim the seftings, cick the <Sound Setfings> button below.

Or, f you use Dualwatch, make sure that the Microphone of the USB audio is set to 2 channels on the

Windows "Sound Settings” screen. If it is set to 1 channel, the receive audio for the Sub band cannot be
output

Sound Settings

N

=1 | Click

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

3 Sound X

Playback Flzcording Seunds Communications

Select a playback device below to madify its settings:

Speakers
High Definition Audio Device
o Default Device

| Digital Audio [S/PDIF)
Hiah Definition Audio Device

3 Sound X

Flaybac| Recording Solnds Communications

Select a recording device below to modify its settings:

Microphone
High Definition Audio Device

o Default Device

NOTE: Before “Step 2. Settings on the Remote PC’s Remote Utility application”
Confirm the Server PC settings described below.

* PC name or IP Address

» User ID and Password registered to the Remote Utility

® Keep the transceiver’s power ON and open the Remote Utility.
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

TIP: Server PC name and IP address
If you configure the remote control system through a LAN, Remote stations can access the server using the
Server PC’s computer name (Device name) or IP address.

A computer name is used on networks to identify a particular workstation on the network.
The example below describes how to find out the Server PC’s computer name or IP address to be requested by
Remote stations. Find out your PC’s computer name.

1. Click the folder icon on the taskbar. 3. The “System” screen is displayed. Confirm the
name that is displayed in Device name.
B Q serch S kO = |Click S—
: : “ . » . « . " S System > About
2. Right-click “This PC,” and then click “Properties.” | & == ‘
S o ?irff_fpfcwkm Rename this PC
€ Home x + =
|8 system Copy .
© Bluetooth & devices .
- e Devicename  ServerPC Conflrm
2~ £ Home > v C Search Home p @ Network & internet
Installed RAM
e o / Personalization s
> @ Onediive Open in new tab B ops :y;mif,
[} Open in new window S Accounts Pen and touch
¥ Downloads 52 Map network drive... e
= Document s 2 Disconnect network drive...
1A Pictures. > Pin to Quick access .
@ Music £ Pin to Start @ CIICk
& Videos I > Properties AltEnter I
£7 Show more options Shift+FI0

' @ nght-chck edlocally

~ Favorites

L}
a

25items
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CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

TIP: Server PC name and IP address (continued)

Right-click the Network icon on the taskbar, and
then click “Network Connections.”

Installed apps
Power Options
Event Viewer

System

Device Manager

Network Connections @ Click

S| Sign out

@ Right-click

Click “Advanced network settings.”

Setiings

® Network & internet
@ coalAccount

[ Ethernet
e — Connected

System

Properties o Datausage
O piicnemorc B 1508 et 304y

Tarar
@ Windows Update

Advanced network settings
2 View s network sdaprers ok rses

Click

® When using Windows 10, click “Change adapter
options” and go to step 4.
Click “More network adapter options.”

& Setings = @
® > Advanced network settings
@ Low o
Network adapters
Find a seting a e
& i — s Dissble v

Related settinas

More network adapter options @

Click ¢

Windows Firewall

@ Gethep

& Give feedback

Right-click “Ethernet,” and then click “Status.”

& Network Connections

@ Right-click

fkand Intemet > Network Connections

ose this connec tion  Rename this connect tion  View status of

An IP address is a numerical label that is assigned to devices participating in a computer network.
Find out your PC’s IP address.

1. 5. The Ethernet Status screen is displayed, and

then click <Details...>.

U Ethemnet Status X
General
Comnection
IPv4 Connectivity: Internet
IPv6 Connectivity: No network access
Media State: Enzbled
Duration: 00:35:04
1.0 Gbps
Activity
Sent A Received
Bytes: 7,200,535 3,233,305
®pProperties | ¥ Disable Diagnose

Close

The Network Connection Details screen is
displayed, and then confirm the IP address that is
displayed in the Address field.

Click <Close> to close the window.

Network Connaction Details X

Network Connection Details

Property Value
Connection specific DN
Description

Physical Address

DNHCP Frabled

1Pv4 Address 192168010 | @ -
TPva Subnet Mask Z23.293.255.00 confl rm
P4 Defaut Gateway

IPv4 DNS Server

IPv4 WINS Server
NetBIOS over Tepip En...
Linkdocal IPvE Address
IPv6 Default Gateway
IPv6 DNS Servers

[(= ] @ click

TIP: When DHCP Enabled is set to “Yes” in the
Network Connection Details screen, the DHCP
server assigns a dynamic IP address to your
PC. Therefore, Remote stations have to match
the IP address each time to access the Server
PC.

If DHCP Enabled is set to “Yes,” we
recommend that you let Remote stations

access the Server PC using its computer name.
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STEP 2. Settings on the Remote PC’s Remote Utility application

CONFIGURING THE SYSTEM THROUGH A LAN

This section describes how to setup the Remote PC.
® Before configuring the settings, connect a speaker and microphone or headset to the PC.

1

2

Open the Remote Utility.
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Ultility, this
screen is displayed.

Configure the settings.
® When you first open the Remote Ultility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: User PC)
® DO NOT use the same name for more than one
PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® You should use the default port numbers for
these ports.
Select the network connection type.
Select your Internet access line type.
Select the software display language.
® The selected language will be used as the Help
file language.
Click <Register> to save the settings.
Click <OK>, and then restart the Remote Utility.

ahw

N o

Click the Setup that you want to do.

® If no servers nor no radios are registered, this
screen is displayed.

Click “Setup for a Remote PC (A radio with the

Server function)” or “Setup for a Remote PC

(Connect through a Server PC).”

® Example: “Setup for a Remote PC (A radio with the
Server function)”

Start the Setup Wizard.
Click <Next>>.

Remote Utility x

Set your own PC information.

1] click
Settings 7 % W
o ] Enter
Control Port (UDP) | 50001 ‘
Serial Port (UDF) 50002 C .
onfirm
Audio Port (UDP) 50003 ®‘
NetworkComecton 3 Select
Internet Access Line [ |FTTH =l @ select
® Select

® Click
v

Remate Utility X
The changes will be effect after the application restarts.
Setup Wizard ? X

Click the Setup that you want to do.

- <4

Setup for a Remate PC
(A radio with the Server function)

=

Setupfora Local PC
{Directly connect the radio and PC) (The rad

Click 'Q

Setup for a Remate PC
(Connect through a Server PC)

- -

Setupfora Server PC
o is accessible by Remote PCs))

Setup for a Remote PC ? X

Start the Setup Wizard

Setup for a Remte PC.

Register a Radio with the Server function that is connected to a LAN

To continue, click <Next>
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CONFIGURING THE SYSTEM THROUGH A LAN

Enter the Server Information.
1. Enter the transceiver Network Name or IP
Address.
® When using a Server PC, enter the Server PC’s
computer name or IP address. (p. 3-8)
2. Confirm the Control Port number.
® You should use the default port number for this
port.
3. Click <Next>>.

Enter the User ID and Password.

1. Enter the User ID and Password that are
registered to the transceiver.

2. Click <Next>>.
« After clicking <Next>>, connects to the server.

Adding the Server has been completed.
1. Enter the Server Description.
® The Server Address or Network Name is
entered by default.
2. Click <Finish>.

3-11

STEP 2. Settings on the Remote PC’s Remote Utility application

Add a Server ? X

Server Information
Enter the Server Address or Network Name and Control port,

Enter the Server Address or Network Nams. and then click <Next>
if the Control port of the Server is changed, enter the number.

Server Address or Network Name
1C-7851

| @ Enter
| @ confirm

Control Port (UDP)

50001
<Back Next > @ Click
Add a Server ? X

User ID and Password
Enter the User D and Password to use to access the Server

Enterthe User ID and Password that are registered to the Server.
Click <Next>to connect to the Server.

User ID

USER1

password [l @ Enter

(Example: USER0001)

_sea| | e | | @ Click

TIP: If you cannot connect to the server, an error
dialog is displayed.
Click <<Back>, and confirm the settings.

Add a Server ? x

The Server Connection failed

The Server is not found. Cannot connect to the Server.
Click <Back> and confimm the Server address or Network name

Or click <Next>to save the Server.

Cancel

Add a Server ?

Add completed

Addingthe Server has completed.
Erterthe Server description. Click <Finish, ¥ there is nothing to change

@ Enter

Server Description

The following radios that are registered to the Server are added to the Fadio List
To connect to the radio, using the Radio List screen,
- |C-7851abc

_ [l J]@click




3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 2. Settings on the Remote PC’s Remote Utility application

Configure the settings to connect to the [B8 com Remere ity - x
transceiver. e e i 1y
1. Select the transceiver. (G785 12b0
2. Click <Settings>.
3. Click <Recommended>.
» The Select Network screen is displayed. 0
4. Select LAN. .
5. Click <Next>, © Click
» The recommended values for your network are
displayed.
6. Click <Yes> to automatically set the
displayed values in each field of the Network
Setting, then close the Select Network
screen. |—| .
7. Select a virtual COM port number. =] @ Click | | |
® The selected COM port number is used for v
CI-V operation with the transceiver.
® When you connect to the transceiver with the (T m——— o
Remote Controller, you have to set the COM e e
port number. SampleRates |60 | [oe =
8. Select an audio device in Speaker that your Coces [l 2a 166t =] [0 s =
speaker is connected, to output the received el ——— 3 Sl
audio from the network. 7 Rt o i ® Click
9. Select an audio device in Mic that your
microphone is connected, to transmit the A 4
input audio to the network. ST .
10. Click <OK>.
Choose the connection method to a server,
e et e, @ Select
) In:::cmd through the Internet.
L= 1] ® Click

v

Remote Utiity

Updates the connectian information in the fallowing contents, OK?

AF Transmission : Enabled
Sample Rates : 16kHz
Codecs : LPCM 2ch 16bit
Prebuffer: 80

MOD Transmission : Enabled
Sample Rates : 8kHz
Codecs : LPCM 1ch 16bit
Prebuffer: 100

Retransmission Audio Data : Enabled

1| ® Click

) 4

IC-7851abc (IC-7851) ? X
Network Setting

IV AF Transmission ¥ MOD Transmission
Sample Rates [ 16z = [se =]
Codecs [LpcM 2¢h 16bit =] [t 1ch 16bit |
0

Prebuffer {ms) '7 80 — '— 10
¥ Retransmission Audio Data Recommended

- @ Select
sl COMPor b | ST I | ‘

Speaker |Defauit Device I 'ﬁ Select

Vic |Default Device = |= s
Virtual Audio Sample Rates (change effectve after the appication restarts.) |48l @ Select
|

=_1|- 19 Click
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 2. Settings on the Remote PC’s Remote Utility application

Connect the transceiver.

1.

Click <Connect>.

* The dialog that indicates the virtual serial port is
displayed.

@ If the connection fails, and an error screen is

displayed, solve the problem. (p. 7-2)

Click <OK>.

» “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

[BY 1com Remote Ltility
File SetupWizard Options Help

Radio List | er List |

IC-7851abc

{"Gettings ‘ Connect @ Click J MoD | Monitor | Delete

3-13
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Remate Lhility X

Virtual serial port number is (2).

1] @ click




3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 3. Starting the Remote control operation

This section describes how to connect and start remotely controlling a transceiver from a Remote PC
using the Remote Controller.

The description in this section is based on the assumption that the connection to the transceiver using the Remote
Utility has succeeded. (“<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Version 2.
2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: 1IC-7851 (Ver1.41 - ) (DUAL))
4. Select the connection between the transceiver and PC in Connection. (Example: LAN)
® When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: IC-7851abc)
» The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s CI-V address, and baud rate.
® If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < > or “Exit” on the File menu.
® When you shut down the PC while the Remote Controller application is still running, the transceiver may not be
turned OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

[connect Setting Fa

todel
|\E 7850/7651 [Verl 41 - DUAL) v| @ Select

Connection

[ ]| @ Select

Remote Utiity

[cmee ]| (5 Select
Search
Cl

COM Port Baud ratelbps)
2 I ET - i

C1V sddiess CIY address |
Fiadio]

(RS-BA1]

e e =)

Auio Device [Veice Memon]
ee the
HeIp file ICOM_VALDIO (icom Vinual Aud =

[ [ ICFWA o ICPW2 i connected,
; -

I The radio is automatically set to T side.

@ Click @:onwaueclosmgtumsUFFmeRadm. |
@ Click
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 3. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select an appropriate connector in MOD Select (Remote ON) (Example: LAN), to input transmit audio
from the PC to the transceiver.

3. Click the close button to close the screen.

MIC SET X | @ Click

MOD Select
[Remate OM] @ Select

I

MOD LEVEL

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the
[F1] key on your PC’s keyboard.

NOTE:
* DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
3. Turn OFF the transceiver and the PC.
@ If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
* When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
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B 4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

Examples of the remote control system through the Internet

This section explains the minimum required settings to configure a remote control system through the
Internet, using the following illustrations as examples.

® Only the Remote PC users whose ID and password are registered to the Base station transceiver or the Server
PC can connect to it. BE CAREFUL in managing IDs and passwords.

® You can also refer to each application’s help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the help file.

A. When using the transceiver with the Server function (p. 4-5)

e

INTERNET

|

Router Router

RC-28
(Purchase
separately)

|

-,

Base station transceiver
(Connect to wireless LAN)

Base station transceiver

Name: IC-7851abc Name: User PC
CI-V address: 8Eh

User ID: USER1
Baud rate: 19200 Password: USER0001

Remote PC

B. When using the Server PC (p. 4-7)

AN

Router Router RC-28
(Purchase
separately)

Transceiver Server PC Remote PC
Name: Server PC Name: User PC
IP address: 192.168.0.10 User ID: USER1

Domain name: ServerPC Password: USER0001

® The user ID, password, and other settings in these TIP: If you use an RC-28 REMOTE ENCODER
illustrations are only examples. Configure the connected to the Remote PC, you can use the
system using your own settings.

RS-BA1 and feel like you are using the actual
transceiver’s MAIN dial.
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

About a public IP address and the Dynamic DNS service

If you configure the remote control system through the Internet, PCs can connect to the transceiver using its public
IP address or domain name.

< To let PCs connect to the Base station using its public IP address

A public IP address is an address that is accessible over the global Internet. Check the router’s manual about how
to configure your router to set the public IP address.

NOTE:

* If you have a dynamic public IP address, we recommend that you use the Dynamic DNS service to enable the
PCs to connect to the transceiver.

« If the PC connected to the transceiver is not using the Dynamic DNS service, you need to change setting of
PC’s Remote Utility to connect to the transceiver each time its public IP address changes.

INTERNET
IP address
WAN:  sieskesk skeoskesk sk skeskesk R =
LAN:  192.168.0.1 outer outer
A
Server PC

Base station transceiver
(Transceiver with
the Server function)

Remote PC

Request “sksksk skskesk sk skskek”

(Public IP address)
Transceiver
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

About a public IP address and the Dynamic DNS service

< To let PCs connect to the Base station using its domain name

If you set up an account for a Dynamic DNS server, the DNS server resolves the domain name into your dynamic
IP address. Using the domain name, PCs can connect to the Base station through the Internet, even if the Base
station’s public IP address is changed.

® Check the router’s manual about how to configure your router to use the Dynamic DNS services.

Dynamic DNS

Server {_x

Update with your INTERNET
dynamic IP address

IP address /

WAN:  skesteske sieskesk skeskesk sk

LAN: 192.168.0.1
Domain name: Router Router

icom-rsbal.com

A
Server PC

Base station transceiver
(Transceiver with
the Server function)

Remote PC

Request “icom-rsbal.com”
(Domain name)

Transceiver
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CONFIGURING THE SYSTEM THROUGH THE INTERNET

Port forwarding

If you configure the remote control system through the Internet, you need to configure your router to enable

connections from the Internet.
To enable connections, forward the port used with the Remote Utility.

NOTE: Icom is not responsible for any accidents caused by the security degradation after this port forwarding.

Base station transceiver

INTERNET

Forwarded port numbers

Forwarded port numbers
50001 ~ 50003

50001 ~ 50003 Router Router

B Server PC
Static IP Address:
192.168.0.100

(Transceiver with
the Server function)

Static IP Address:
192.168.0.100

Remote PC
Static IP Address: 192.168.0.100

Transceiver
Default Gateway: 192.168.0.1

DNS Server address: 192.168.0.1

Example: The transceiver directly Example: The transceiver connected to the

connected to the network network through a PC
Default Gateway: 192.168.0.1

Set the static local IP address to the Base station or Server PC.
Set a static local IP address to the Base station or Server PC.

® Information
*» Usable IP addresses differ, depending on your router. Check the router’s manual for details.

* DO NOT set the same IP address to 2 or more devices that are connected to the same router.
» Check your PC’s manual about the setting details.

Transceiver setting

Items Contents
DHCP ON (Default) — OFF
An IP address that is not assigned to any other device.
IP Address Example: 192.168.0.10 (Defa?JIt) ’
Default Gateway An IP address of the LAN side on the router
Example: 192.168.0.1
Control Port (UDP) 50001 (Default)
Serial Port (UDP) 50002 (Default)
Audio Port (UDP) 50003 (Default)

Forward the port.

» Forward port numbers that are used for the RS-BA1. (Default: 50001 ~ 50003)

» “UDP” should be used as the port protocol.

» Set a static local IP address in step 1 as a destination port.

® Check the router’s manual about how to forward ports.

® Depending on the router settings, you must configure the IP filter settings. Check the router’s manual how to configure
the settings.
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function
Set each setting item on the Base station transceiver.

NOTE: When you change a setting that displays “(Valid after Restart),” you must restart the transceiver after
setting. After restarting, keep the transceiver’s power ON or remain in the remote standby mode.

Network setting User registration
Items Contents Items Contents
Network Control OFF (Default) — ON Network User1/2/3* A User ID
® Up to 16 characters
Your Internet access line ID Example: USER1
type
Internet Access Line | Example: FTTH (Fiber To A Password
The Home) + | ® 8~ 16 characters
(Default) EetworkéJseH 213 ® At least 2 different
asswor characters must be used.

Example: USERO0001

NO (Default) — YES
® When the user is set as an
administrator.

Network User1/2/3*
Administrator

* There is no User3 in the IC-7610, 1C-9700, IC-705,
or IC-905.

NOTE: To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters.
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function (Continued)

Transceiver registration

Items Contents

A Network Radio Name
Network Radio Name | ® Up to 16 characters
Example: IC-7851abc

Transmit audio setting
(For the IC-7800 and IC-7700)

Items Contents

Network MOD Use ON (Default)

TIP: Standby mode setting

To remotely control the transceiver using the RS-BA1, the transceiver should be turned ON or be in the standby
mode.

To set the transceiver in the standby mode, set the item described below and select

“Standby (for Remote Control)” on the displayed screen when you turn OFF the transceiver.

® The LED above [POWER] slowly blinks orange if the transceiver is in the standby mode.

Items Contents

Shutdown Function
(For the IC-7700, IC-7800, IC-7850, IC-7851)

Standby/Shutdown
Power OFF Setting (for Remote Control)
(For the IC-7610, IC-9700, IC-705, 1C-905)

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 4-11)
Confirm the settings described below.

* Public IP address or Domain name (p. 4-2)

» Base station’s Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode
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STEP 1. Settings on the Base station

CONFIGURING THE SYSTEM THROUGH THE INTERNET

< B. When using the Server PC
Connect the transceiver to the Server PC and setup the Remote Utility.

1

5

Connect the transceiver to the Server PC.
Connect the transceiver to the Server PC with a
cable.

® See page 2-2 about the connection.

Open the Remote Utility.
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Ultility, this
screen is displayed.

Configure the settings.
® When you first open the Remote Ultility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: Server PC)
® DO NOT use the same name for more than
one PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® You should use the default port numbers for
these ports.
Select the network connection type.
Select your internet access line type.
Select the software display language.
® The selected language will be used as the Help
file language.
6. Click <Register> to save the settings.
7. Click <OK>, and then restart the Remote Utility.

o ke

Click the Setup that you want to do.

® If no Servers and no radios are registered, this
screen is displayed.

Click “Setup for a Server PC (The radio is

accessible by Remote PC(s)).”

Start the Setup Wizard.
Click <Next>>.

4-7

Remate Utility X

Set your own PC information.

1 | click

Settings

7 X W
@ Enter

PC Name

Control Port (UDP) | 50001 ‘

Serial Port (UDF) 50002 @ C .
onfirm

Audio Port (UDP) 50003 |

Network Connection [ |wired ] @ Select

S @ Select

® Select

=== (6 Click

A 4

Remote Utility X
The changes will be effect after the applieation restarts.
\
Setup Wizard ? X

Click the Setup that you want to do.
Setup for a Remote PC
{Aradio with the Server function)

=

Setup for a Local FC
{Directly conmect the radio and PC)

Setup for a Remote PC
(Connect through a Server PC}

- -

Setup for a Server PC
(The racio is accessible by Remate PC(s))

Click

Setup a Server PC
Start the Setup Wizard

Setup  Server PC

Register a Radio that is directly connected to the PC to use remote operation from other PCs.

To corttinue, click <Next>

I Click
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STEP 1. Settings on the Base station

< B.

6

8

CONFIGURING THE SYSTEM THROUGH THE INTERNET

When using the Server PC (Continued)

Select a Radio for the Remote operation.
1. Select a transceiver that you want to add.

@ If the transceiver has already been registered,
select “Registered radios” and select it from the
drop-down list.

2. Click <Next>>.

Selecting a Radio
® If you select “Registered radios” in step 6, go to the
next page (step 9).
1. Select a connection type (Example: USB).
@ If the transceivers are not listed, click <Search>.
® Select “Manual” if the transceiver is connected
to the PC using other than a USB cable.
Select the connected transceiver from the drop-
down list.
2. Click <Next>>.

Set the CI-V/ICOM port settings.
® If you select “Registered radios” in step 6, go to the
next page (step 9).

1. Set the CI-V address, Baud Rate, and COM
Port Number.
® If you select “USB” in step 5, there are no

necessary changes.
2. Click <Next>>.

4-8

Register a Radio ? b

Select a Radio for Remote operation
Select a Radio that is accessible from other PCs

Select [new] i you want to register a new radio that is accessble from other PCs
Or select from [Registered radios].

After selecting. click <Next>

* New!
¢ Registered radios [select = radic =1
== Jﬂl C I i CK
[
Register a Radio ? 53

Selecting a Radio
Select a Radio that you wart to add

[ the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click
<Next>. I the radio is not listed. confirm the radio is ON and the cable is fimly connected. Wait for a while urntil
the PC recognizes the device, and then click the <Search> button

I the radio is connected to the PC using otherthan a USE cable, select from the radio from the [Manual]
drop-down list. Then click <Nesdt>

1C-7300 coM=3 -

Search

& [f

T ) Select

[=Toa

Register a Radio ? 53

CI-V/COM port Settings
Set the IC-7300°s C1 settings.

f you wart to change the CHV address and/or Baud rate, change from the lists belaw.
The Radio has the Spectrum scope function, f you se the function on the Remote Controllr, the USB Baud
rate must be set to 115200 bps. At this time, also corfirm the setting of the CI-V USB Port item is "Unlink to
[REMOTE]".

The COM port number is automatically set. ff they are no necessary changes, ick <Next>

Address |94
Baud Rate |115200 hd

@ Set
COM Port Number |COM3

oo @ Click
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STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

CONFIGURING THE SYSTEM THROUGH THE INTERNET

When you select “Manual” in step 7:

The Audio Settings screen is displayed.

Select the devices that input a received audio from
the transceiver and output a modulation to the
transceiver, and then click <Next>>.

r
Register a Radio ? X

Audio Settings
Set the audio of the Radio

Select the devices that input @ received audio from the radic and output @ medulation to the radio,
Ater selecting, dlick <Next>

[(## moutoeviee e I - | | @ Select

| MOD Output Device | Mot used -| |E @ Select
Device Gptions
Search

[ Displays Detected Radic's Device

I Displays virtual Device

9 Register a User to allow a connection.

1.

wn

No ok~

Click <Add>.
» The Add User screen is displayed.
Enter a User ID. (Example: USER1)

Enter a password of more than 8 characters.

(Example: USERO0001)
Click <OK>.

Select a registered user.
Click <Add >>>,

Click <Next >>.

NOTE: To prevent unauthorized access

Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers

or characters.

Register a Radio ? b

Register a User to allow a connextion
Rlegister o User to allow a connection 1o 157300

Register a Userto allow a connection. If no user s registered, click <Add> to register the Add User screen. You
can change this setting later.

Registered Users Accessible Users
Add>>
<<Delete
@ Click
< Back Mext > Cancel
[add User S

@Enter |User]D [oser:

©) @ winn €
N
Enter | - ==

(Example: ——
USER0001) @ Click To set the user as
an administrator,
click to put a
check mark.
Vv
Register a Radio ¢ £3

Register a User to allow a connection
Register a User to allow a connection to |C-7300

Register a Userto allow a connection. f no useris registered. cick <Add> to registerthe Add User screen, You

= ter,
@ Click @ Click eu-
USERL (Admin) USERL (Admin
<<Delete
Add

_cx | we || (D Click




4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

10 Enter the radio name. ety rox
1. Enter the radio name. e e i o K700
® The radio’s model name and the last 5 digits of e
the serial number is entered by default. e
2. C“Ck <Next>>_ Click <Nex > to register to the Radio
RodoName [1G73000 0 @ Enter

11 The registration of the Radio is completed.
Click <Finish>. Register a Radio 5

Add Completed

The registration of the Radio is completed. To connect to the Radio, using the Radio List soreen

Attention:

By connecting the Radiato a USB port, the defaut settings on the REC/PLAY device window may change to
the Radio’s Speaker and Microphone.

Inthat case. o sound comes from the original speaker. or you cannot input audio from the microphone. To
confim the seftings, cick the <Sound Setfings> button below.

Or, f you use Dualwatch, make sure that the Microphone of the USB audio is set to 2 channels on the

Windows "Sound Settings” screen. If it is set to 1 channel, the receive audio for the Sub band cannot be
output

Sound Settings

N

@ Click

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

3 Sound X

Playback Flzcording Seunds Communications

Select a playback device below to madify its settings:

Speakers
High Definition Audio Device
o Default Device

| Digital Audio [S/PDIF)

Hiah Definition Audio Device

3 Sound X

Flaybac| Recording Solnds Communications

Select a recording device below to modify its settings:

Microphone
High Definition Audio Device
Default Device

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 4-11)
Confirm the settings described below.

* Public IP address or Domain name

» Base station’s Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

This section describes how to setup the Remote PC.
® Before configuring the settings, connect a speaker and microphone or headset to the PC.

1 Open the Remote Utility. Remete Uiy x
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Ultility, this
screen is displayed.

Set your own PC information.

T ] Click

2 Configure the settings. it Tox]
® When you first open the Remote Ultility, this screen P ame @ Enter
is displayed. Convolportuop) [ 5000 ‘

1. Enter a name for your PC of up to 16 Spartwor) |[0002 .
characters. (Example: User PC) [ | ®\ Confirm
® DO NOT use the same name for more than Networ Comnection 3 Select

one PC on your network. Internet Acces e @ Select

2. Confirm the port numbers of the Control, ® Select
Serial and Audio ports. ® Click
® You should use the default port numbers for :

these ports. v

3. Select the network connection type. _

4. Select your Internet access line type. e *

5. Select the software display language. The changes il e ftecaier e spalction estart
® The selected language will be used as the Help ‘

file language.

6. Click <Register> to save the settings. @ Click

7. Click <OK>, and then restart the Remote Utility.

Setup Wizard 7 X

3 Click the Setup that you want to do.
® If no servers nor no radios are registered, this
screen is displayed.
Click “Setup for a Remote PC (A radio with the
Server function)” or “Setup for a Remote PC
(Connect through a Server PC).”

Click the Setup that you want to do.

- <

fora Remate PC

Click 'a

Setup Setup for & Remote PC
(A radio with the Server function) (Connect through a Server FC)

A e

Setup for & Local PC Setup for a Server PC
{Directly connect the radio and PC) (The racio is accessble by Remote PCis))

® Example: “Setup for a Remote PC (A radio with the
Server function)”

Start the Setup Wizard.
Click <Next>>.

Setup for a Remote PC ? X

4

Start the Setup Wizard

Setup for a Remote PC

Register a Radio with the Server function that is connected to a LAN

To continue, click <Next>,
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

Enter the Server Information. held s Server LS
1. Enter the Base station’s domain name or et s s et oo nd Cortl ot

public IP Address.
2. Confirm the Control Port number.
® You should use the default port number for this
port.
3. Click <Next>>.

Enter the Server Address or Network Nams. and then click <Next>
if the Control port of the Server is changed, enter the number.

Server Address or Network Name
fmmat | (D Enter

Control Port (UDP)

Eone | @ confirm

[l = | | ® Click

Enter the User ID and Password. T PR
1. Enter the User ID and Password that are

registered to the transceiver.
2. Click <Next>>. O o St 1 o e rel 10 he Soreer

« After clicking <Next>>, connects to the server.

User ID USER1

password [l @ Enter

(Example: USER0001)

e | || (D Click

TIP: If you cannot connect to the server, an error
dialog is displayed.
Click <<Back>, and confirm the settings.

Add a Server ? x

The Server Connection failed

The Server is not found. Cannot connect to the Server.
Click <Back> and corfim the Server address or Network name.

Or click <Next>to save the Server.

{7CBack 7Y Next»> Cancel

7 Adding the Server has been completed. Ao a Serer ?
1. Enter the Server Description. Add completed
® The Server Address or Network Name is
entered by default. Aﬂ??h@?sf:fﬁg::n;ﬁ?np‘ecﬁ <Finish. # there is nothing to change.

2. Click <Finish>. e
oo oo oo (D Enter

The following radios that are registered to the Server are added to the Fadio List
To connect to the radio, using the Radio List screen,
-IC- abc

_ [ ] ®@click
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

8 Configure the settings to connect to the Base fﬁ eonterae iy - %
A File SetupWizard Options Help
station. . Radio List | server List |
1. Select the transceiver. IC-7851abc

2. Click <Settings>.

3. Click <Recommended>.

» The Select Network screen is displayed.

Select Internet.

Click <Next>.

» The recommended values for your network are

displayed.
6. Click <Yes> to automatically set the
displayed values in each field of the Network
Setting, then close the Select Network
screen. |—| .
7. Select a virtual COM port number. =] @ Click | | |
® The selected COM port number is used for v
CI-V operation with the transceiver.

® When you connect to the transceiver with the e e feomrbatom) X
Remote controller, you have to set the COM o e ¥ 1D Trenemision
port number. sampeRates [z Sl =

8. Select an audio device in Speaker that your o e imew
speaker is connected, to output the received R —— .
audio from the network. - @ Click

9. Select an audio device in Mic that your v
microphone is connected, to transmit the

101 =1 0=2]

@ Click

ok

. . Select Network ? X
input audio to the network.
10 C||Ck <OK>_ Choose the connection method to a server.
AN

Directly connected or through a network hub.

& Intemet;

Connected thraugh the Internet. @ Select

Or connected via VPN, Choose this. ‘

L= 1|:® Click
4

Remote Utility

Updates the connection information in the following contents, OK?

AF Transmission : Enabled
Sample Rates : 16kHz
Codecs : LPCM 2ch 16bit
Prebuffer: 120

MOD Transmission : Enabled
Sample Rates : 8kHz
Codecs : LPCM 1ch 16bit
Prebuffer: 150

Retransmission Audio Data: Enabled

1C-785Tabe (jcom-rsbal.com) ? X
Network Setting
¥ AF Transmission [¥ MOD Transmission
SampleRates |16z =] [se =l
Codecs [Pt 2ch 16bit ] [tpcm 1ch 15t =
Prebuffer (ms) 7J7 20 02— I— 150
[¥ Retransmission Audio Data M
Device Settinas @ Select
el Comportumber [ - | -
Specker |Default Device ~11= (8 Select
Mic | Defauit Device ] s
virtual Audio Sample Rates (change effective after the application restarts.) |¥ @ Se Iect
)
oK A
- (0 Click
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

[BY 1com Remote Ltility
File SetupWizard Options Help

Connect the transceiver.

1. Click <Connect>. Radotit | sover st
* The dialog that indicates the virtual serial port is |C_7851abo
displayed.

@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-2)
2. Click <OK>.
» “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

{"Gettings ‘ Connect @ Click J MoD | Monitor | Delete

v

Remate Lhility X

Virtual serial port number is (2).

@ Click
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 3. Starting the Remote control operation

This section describes how to connect and start remotely controlling a transceiver from a Remote PC
using the Remote Controller.

The description in this section is based on the assumption that the connection to the transceiver using the Remote
Utility has succeeded. (“<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Version 2.
2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: 1IC-7851 (Ver1.41 - ) (DUAL))
4. Select the connection between the transceiver and PC in Connection. (Example: LAN)
® When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: IC-7851abc)
» The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s CI-V address, and baud rate.
® If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < > or “Exit” on the File menu.
® When you shut down the PC while the Remote Controller application is still running, the transceiver may not be
turned OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

[connect Setting %

tdodel
| |G- 785047651 [Ver] 41 -] DUAL) v| @ Select

Connectior

[ ]| @ Select

Femote Ulility

femiee ]| (5) Select
Seaich |

LY
COM Port Baud ratelbps)
2 =] [1az00 -

CIV address CI address
(Radic) (R5-BA1)

& E0 >

See the “Audio Deviee [Voice Memory)
He|p file ICOM_VAUDIO- [lcom Yirtual Aud -

[ [ ICFW1 or ICPW2 is connectzd,
; r

|~ The radio iz automatically et to T side.
@ Click @:ofkware clasing tums OFF the Radio. |
@ Click
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 3. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select an appropriate connector in MOD Select (Remote ON) (Example: LAN), to input transmit audio
from the PC to the transceiver.

3. Click the close button to close the screen.

MIC SET > || ® Click
ROD Select
[Remate OMN] @ Select
LAM -

MOD LEVEL

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the
[F1] key on your PC’s keyboard.

NOTE:
+ DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
3. Turn OFF the transceiver and the PC.
@ If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
» When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
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ABOUT THE REMOTE UTILITY

Setting your PC’s environment

Configure your PC’s environment in the Remote Utility.
The settings will take effect after rebooting the Remote Utility.

® When you first open the Remote Utility, the Settings screen is displayed.
After configuring the settings, you can display other setting screens.

1. Click “Options.” B feom Remote s <
H “ . ” File Setup Wizarc| Options H
2. Click “Settings. Rst75®C!'CK
+ The “Settings” screen is displayed. IC_7851a @ Click

3. Configure the settings.
4. Click <OK> to save the settings.
* “The changes will be effect after the application
restarts.” is displayed.
5. Click <OK>.
® The settings will take effect after restarting the
Remote Utility.

©PC Name
Enter a name for your PC of up to 16 characters.
@® DO NOT use the same name for more than one PC on your network.

@ Port numbers
Enter the port numbers of the Control, Serial, and Audio ports.
You should use the default port numbers for these ports.

© Network Connection
Select the network connection type.

O Internet Access Line
Select your internet access line type.

© Language
Select the software display language.
The selected language will be used as the Help file language.

v

(3 Set

? X

PC Name

Control Port (UDF)

Audio Port (UDP)

Language

Serial Port (UDP)@ 50002

Network Comecto @) [wred 7]

Internet Access Lin

o User PC
50001

50003

(4 G &
o

L= 1@ click

v

Remate Utility

The changes will be effect after the application restarts.

|

® Click

NOTE: If you configure the remote control system through the Internet, and change the port number of the
Control, Serial or Audio port, you should reconfigure the port forwarding settings and the IP filter settings on your

router. (p. 4-4)
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O  ABOUT THE REMOTE UTILITY

Transceiver Registration

In the Remote Utility, register the transceivers that are physically connected to your PC.
See p. 2-2 to connect a transceiver to your PC.

< Adding a transceiver

1. Click “Options.” B com Remote e (@ Click = %

. « . » File Setup Wizard| Options | .
2. Click “Local/Server Settings. o e [ o] @ Click

3. Click <Add>. 1C-7300 Settings..
*» The “Purpose of use” screen is displayed. e L At 84

4. Select an option, and then click <Next >>.

@ If you select “Only accessible from this PC,” the
registered transceiver cannot be operated from v
other PCs. If you want to operate the Base station
transceiver from other PCs, select “Accessible from

Local/Server Settings 7 bd
other PCs.” Registered Rado List | User Managemen
5. Set the transceiver information according to the 1C-7300

displayed screen. Public
® See pages 2-7, 3-4, or 4-7 about the settings.

== | Froper

® Click
Register a Radio 7 X
Purpose of use

Selec the purpose of use of the radic.
Selectthe purpose of use of the radio below, and then click <Next>.

© Select

" Only accessible from this PC

= {ccessible from other PCs)

@ Click
sgerk || medts | Cancel

TIP: When you add a transceiver from the Setup Wizard screen, click “Setup for a Server PC (The radio is
accessible by Remote PC(s).)” or “Setup for a Local PC (Directly connect the radio and PC).”
® To display the Setup Wizard screen, click “Setup Wizard” on the top menu.
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Transceiver Registration

H H 1 Icom Remote Utility . =
< Changing a transceiver’s properties Bl i @ Click )

Click “Options.” oot s [ weiweseine ] (2) Click

Click “Local/Server Settings.” ICT300 % e
Select a transceiver. TiS0leps 01 Addse 4

Click <Properties>. v
Change the settings, and then click <OK>.

arwh =

Local/Server Settings ? X

Registered Radio List | User Management

1C-7300

Public

\I\/\_/_\/\_/T

add | pelete | Properties | |

\ 4 @ Click

Radio Properties ? x
Connected Device Type - ¥ Public

Radio Name [ 167300
¥ cv  address [o4 Baud Rate [115200  ~

~COM Port/Audio Setting
# auto [1c-7300 coM=3 -
" Manual

COMPort Number  [co3 ~

AF Input Device

[0t used E |
MOD Output Device

[Not used N T |

I Displays Detected Auta Device

I Displays Virtual Device:

Search
caree

. . : =
< Deleting a transceiver St @ Click )

Click “Options.” i s [t @ Click

Click “Local/Server Settings.” G780 S
Select a transceiver. T15200bps C1 Addrecs 94

Click <Delete>. A 4

il o\

Local/Server Settings ? X

Registered Radio List | User Management

|C-7300

Public

‘l\/\/\/\/\\

Add >mpemas |
@ Click
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ABOUT THE REMOTE UTILITY

Transceiver Registration

H H com Remote Utilit -
¢ Adding a user who can access the transceiver B« == (@ Click 8
: “ ; ” Radio List | server Lo:a\/SeNerSaﬂmgs ?
1. Click “Options. | _ 2 Click
2. Click “Local/Server Settings.” IC-7300 e ‘
3. Click the <User Management> tab. L15mees (i aghess 30
Local/Server Settings ? X
REg\stErEdRadles @ Click
IC-7300 -
Registered Users Accessible Users
USERL (Admin
Add>>
<<Delete
Add Properties
Delete
Adding a user
1. Click <Add>.
Local/Server Settings [§ x
2. Enter auser ID of up to 16 characters, case ’
g Registered Radio List  User Management
sensitive.
® You cannot register an already registered ID. Kol =
Registered Users Accessible Users
3. Enter a password, of 8 ~ 16 characters, case USERL Cadmm
sensitive. >
® At least 2 different characters must be used. <<odete
4. Click <OK>.

To prevent unauthorized access:

Set a long and strong password so that no one can
possibly guess it. Mix upper and lower case letters,

numbers or characters.

u’perﬁas

@ Click

v

Add User

?

X

@ Enter [z lusm—l

® Enter | @ aain €

(Example. -ﬂ

USERO0002) @ Click

To set the user as
an administrator,

click to put a
check mark.
Local/Server Settings ? X
Registered Radio List  User Management
oo ]

Registered Users Accessible Users
USERL (Admin

Add>>
<<Delete

Add Properties
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Transceiver Registration

< Adding a user who can access the transceiver (Continued)

To allow a user to use a transceiver

1. Select a transceiver that you allow the user to use.
2. Select the user. Local/Server Setings S
3- CIICk <Add>>>. Registered Radio List User Management @ Select

1C-7300 -

Registered Users Accessible Users

USERL (Adminy

@ Click _na> | @ Click
<<Delete ’

|

Add Propertiss
Delete

v

Local/Server Settings ? X

Registered Radio List User Management

1C-7300 -

Registered Users Accessible Users
USERL (Admin Admin
d USERZ (Admin)

<<Delete

Add Proper ties

Delete

3

To inhibit a user to use a transceiver
1. Select a transceiver that you inhibit the user to

use Local/Server Settings ? X
) Registered Radio List  User Management
2. Select the user. (@ Select
3. Click <<<Delete>. ficome =]
Registered Users ‘Acceisrqh\e Users

USERL (Admin’ TR YT E—
. [0 1@ Click

<<Dekte @ Click
|

0

dd Properties

Delete

3
i

<4

Local/Server Settings. 7 X

Registered Radio List User Management

1C-7300 -

Registered Users Accessible Users
USERL (Admin USERL (Admin

Add>>
<<Delete

Add Properties

Delete

Fl
i
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Transceiver Registration

To change a user properties

1. Select a user.
2. Click <Properties>.
3. Change the settings, and then click <OK>.

Local/Server Settings [4

Registered Radio List  User Management

1C-7300 hd

Registered Users Accessible Users

’(D Click :I'

s |[e=e= ] @) Click
Delete

v

User Broperties ? X

usern  [IEEE
Password | =FFTE ¥ admin

L [=]®ciick

To delete a user

1. Select a user.

2. Click <Delete>. e ’

Registered Radio List  User Management

1C-7300 hd

Registered Users Accessible Users

@ Click e |
<<Delete

Properties |

= & lick

v

Local/Server Settings ?

Registered Radio List  User Management I

lC 7300 -

Registered Users Accessble Users

drm ¥ USERL (Admin
Add>>
<<Dalebe

Properties

Dalebe
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Server Registration

To connect to a Base station transceiver through the network, Remote PCs should first connect to a Server using
the Remote Utility. Before connecting, enter the Server information.

< Adding a Server

1. Click <Server List>.
2. Click <Add>.
+ Set the Server information according to the displayed
screen.
® When connecting to a Base station transceiver
through a LAN, see page 3-10 about the settings.
When connecting to a Base station transceiver
through the Internet, see page 4-11.

TIP: When you add a server from the Setup Wizard screen, click “Setup for a Remote PC (A radio with the Server
function)” or “Setup for a Remote PC (Connect through a Server PC).”
® To display the Setup Wizard screen, click “Setup Wizard” on the top menu.

5-7



O  ABOUT THE REMOTE UTILITY

Server Registration

< Changing a server’s properties
1. Click <Server List>. M - x

File SefimMWizard Arbinnc  Holn

2. Select a server. ;
3. Click <Properties>.
4. Change the settings, and then click <OK>.

1C-7851

@ Select

v

Server Properties ? X

Server Description

Network Settings

Server Address Control Port
or Network Name (uoP)
|1c-7351 | 50001
User ID Passwor d

=0 [

I Disable the Server

[ 1| ® Click

< Deleting a server

1. Click <Server List>. [ —— - X
2. Select a server. Hle sty S0 .
3. Click <Remove>.

1C-7851

@2 Select

add Remove || @ Click u Disconnect

5-8



O  ABOUT THE REMOTE UTILITY

Connecting to a Server

< Connecting to a Server

Click <Server List>.

Select a server.

Click <Connect>.

“Connected” is displayed under the Server name

when the connection has succeeded.

@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-1)

pPON=

< Disconnecting from a Server

1. Click the <Server List> tab.
2. Select the connected server.
3. Click <Disconnect>.

5-9

2 Select

IC-7851

Connected

[

server List | @ Click

ne FTTH Round4rip O

2 Select
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Connection setting

When the connection to the Server has succeeded, the Base station transceivers are displayed on the Radio List
screen. Select a transceiver from the list, then connect it to the network using the Remote Utility.
You have to configure the network audio quality and devices to connect.

® To control the transceiver, connect to the transceiver using the Control software.

List screen and then clicking <Connect>.

TIP: If the connection setting is finished, you can simply connect to the transceiver by selecting it on the Radio

Click <Radio List>.

Select a transceiver.

Click <Settings>.

® For the transceivers that are “<<Connected>>" or
“Offline,” the Connection Setting cannot be changed.

4. Change the settings, and then click <OK>.

wh =

NOTE: When using the DUAL mode screen in the
Remote Controller, set the codec setting for
“AF Transmission” to 2 channels.

5-10

[B 1com Remote Utility

File_ Sehun Wisard  Ontinne  Haln

0 [=10-2)

2 Select

@ Click | a | moo | wenter | Delete
IC-785Tabe (IC-7851) ? e
- Network Setting

[V AF Transmission [V MOD Transmission
Sample Rates [16k-2 =] [3e -
Coders [LPcM 2ch 16bit =] [t 1ch 1ebit -
Prebuffer (ms) 0 o —| 100
[¥ Retransmission Audio Data Recommended
- Device Setting:
U ER w2
Speaker [Defauit Device ] [k ~]
Mic [Default Device | [ ~]

virtual Audio Sample Rates (change effective after the application restarts.) |48z =

[C=_1| @ click
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Connecting to a transceiver

If the connection setting is finished, you can simply connect to the transceiver by selecting it on the Radio List
screen and then clicking <Connect>.

< Connecting to a transceiver

1. Click <Radio List>.
2. Select a transceiver.
3. Click <Connect>.
4. Click <OK>,
« “<<Connected>>" is displayed under the radio name
when the connection has succeeded.
® If the connection fails, and an error screen is @ Select
displayed, solve the problem. (p. 7-2)

rﬁ lcom Remate Utility — x

0 [i=10-2]

{ Settings connactl @ click J MOD | Manitar | Delete

Remote Utility X

Virtual serial port number is (2).

| @ click

< Disconnecting a transceiver

1. Click <Radio List>. T -
2. Select a transceiver with “<<Connected>>" under @ Clic

its name. IC-7851abc
3. Click <Disconnect>. << Connacted »>

* “Do you want to disconnect the radio?” is displayed.
4. Click <Yes> to disconnect the transceiver.

@2 Select

NOTE:

* Be sure to disconnect when not using the
transceiver. Otherwise, other users cannot connect
toit.

» The administrators can terminate a connection
between another user and a transceiver. If
“<<Connected>>" disappears while connecting to =] [=—] @ Click || |

a transceiver, the administrator may terminate the

connection. .

Remote Utility

Do you want to disconnect the radio?

|| @ Click
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Adjusting audio level using the Remote Utility application

While connected to a Base station transceiver, you can adjust the received and transmit audio volume through the

network using the Remote PC’s Remote Utility.

The description in this section is based on the assumption that the connection to the transceiver has succeeded.

(“<<Connected>>" is displayed under the radio name.)

< Adjusting received audio volume
1. Click <Radio List>.

2. Select a transceiver with “<<Connected>>" under
its name.

3. Click <AF>.

4. Slide the adjustment bar on the Volume field up or
down to adjust the received audio volume level.
® Click <Mute> to mute the audio, and click once again

to hear the audio.
5. Click <Close> to close the screen.
NOTE:

» The AF adjustment bar on the Volume field
moves together with the AF control of the Remote
Controller. However, if you use another control
software, the audio volume level on the network
can only be adjusted with the Remote Utility.

* You cannot adjust the received audio volume level
of the transceiver’s speaker, with the Remote
Utility. Use the AF control on the transceiver to
adjust it.

* When setting the codec setting for “AF
Transmission” to 1 channel, the volume level of
both right and left are the same.

(B 1com Remote Ltility - X

1 0=2]

2 Select

Settings I:I Disconnect @ Click 4
A 4

IC-785Tabe (IC-7851) ? *
Volume Recording
| ‘ sample Rates [16kttz -
Codecs [tpcm 1eh 1ebie =
T T [ 30 BN Open Folder
00:00:00
odB 0dB
L A R
Mute Mute Rec Folder
I~ LR Mix ‘c: \sers\ \Documents\lcom \Remotelty rec
. Close @ Click
L @ Adjust

5-12

< Adjusting transmit audio volume
1. Click <Radio List>.

2. Select a transceiver with “<<Connected>>" under
its name.

3. Click <MOD>.

4. Select “Mic” in “MOD Select.”

5. Slide the adjustment bar on the Volume field up or
down to adjust the transmit audio volume level.

6. Click <Close> to close the screen.

NOTE: You cannot adjust the modulation input
level of the transceiver with the Remote Utility.
Adjust the modulation input level of the transceiver
in the transceiver’'s Set mode, or using the Remote
Controller. (p. 6-2)

IC-7851abc

<< Connected >>

= [

104 (=1 0-2]

@ Select

seonss | [ | pures| e ® Click - |

v

IC-7851abc (IC-7851) ? X

Volume MOD Select

| & Mic Default Device |

@ Select

> |

VA

® Adjust

" File

00:00:00

Mic " Notused

® Click
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Recording and playback function

While connected to a transceiver, you can record the received audio and save it into the PC’s hard disk using the
Remote PC’s Remote Utility.

Also, you can transmit an audio file to the radio using the Remote Utility.

The description in this section is based on the assumption that the connection to the transceiver has succeeded.
(“<<Connected>>" is displayed under the radio name.)

< Recording received audio

1. Click <Radio List>.
2. Select a transceiver with “<<Connected>>" under E
itS name. IC-7851abe

[ﬂ lcom Remote Utility - X

Fil=_ Sebun Wisard  Owbinne Haln

3- CIiCk <AF>_ << Connected >> i
4. Click < ®/> to start recording.

® While recording, click < Il > to pause.
5. Click < ®/> to stop recording.

TIP:
* When you click <Open Folder>, the folder in which
the recording file is saved is displayed.

« If you want to change the recording folder, click e | e @ Click |
< - >, then select a folder on the Browse For
Folder screen. .

+ Adjust the sample rate frequency and codec

; h ; Record button
to record the audio according to the recording
purpose. When you record the audio received Stop button
from the network, we recommend that you set the —— Pause button
same sample rate frequency and codec that are
programmed on the Connection Setting screen. e , T
Volume F|-cordir|;
‘ | 5| nple R tes |
ofecs Fome: =
je mn opracer_[e——— Open the folder
B Recording file name
w o || Elapsed time
L AF R
Mute Mute Rec Folder
™ LR Mix ‘C:‘-users‘ \Pocuments\Icom\RemoteUtyyec 7 J
I Close I |

Recording folder name Folder browse button
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Recording and playback function

< Playing back and transmitting an audio file

1. Click <Radio List>.
Select a transceiver with “<<Connected>>" under

its name.
3. Click <MOD>. << Connected >>
4. Select “File” in “MOD Select.”
5. Click <Open> to select an audio file* to play or

transmit.

* Only uncompressed, linear, PCM WAV files are

supported.
6. Click < » > to start playing/transmitting.
® While playing or transmitting, click < 1l > to pause.
7. Click < ®> to stop playing/transmitting.

Settings | Dismnne:t| AF @ Click J

TIP: You can also use the Remote Controller’s Voice A 4

Memory function to play back or transmit an audio

file. See the Remote Controller’s help file for details. — Playback button
To display the help file, click “Contents” in the Help —— Stop button
menu on the Remote Controller, or push the [F1] key —— Pause button
on your PC’S keyboard' IC-7851abc (IC-7851) ? x

Volume MOD Select:

" Mic | <fautt | devic
C v Audio 1):om_{aupif-1
T @ Fie »|mi| [[_o= e Open the folder
C\sersh \com RemoteUty| Audio file name
00:00:00 Elapsed time

0dB

File " Notused

Close
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Monitoring another users from the Server PC

When you are operating a Server PC, and another user is accessing a Base station transceiver that is physically
connected to your PC, you can monitor the received and transmitted audio.
® To monitor, you should connect a speaker to your PC.

1. In the Server PC’s Remote Ultility, click the <Radio
List> tab.

2. Select a transceiver with “Busy” under its name.

® The operating user’s name (PC Name that the
Remote PC set in the Network Setting screen), and
its IP address are displayed under “Busy.” it Do

Click <Monitor> to display the Monitor screen. —

Click <TX Monitor> to turn the Transmit Monitor @ Select

function ON or OFF.

Click <RX Monitor> to turn the Receive Monitor

function ON or OFF.

Slide the adjustment bar on the Volume field up or

down to adjust the monitoring audio volume level.

B w

5. Click <Close> to close the screen. sctings | | covect | Diereet| | s || oo ®) Click
d
X
TX Monitor .
RX Monitor 0 CIICK
@ Adjust
[==_1| © Click
S |
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Disconnecting another users

The administrators and the Server PC can terminate a connection between another user and a transceiver.

Click <Radio List>.

Select a transceiver with “Busy” under its name.
® The operating user’s name (PC Name that the user
set in the Settings screen), and its IP address are

displayed under “Busy.”
3. Click <Disconnect>.
* “The radio is in use by a remote PC. Do you want to
disconnect?” is displayed. @ Select
4. Click <Yes> to terminate the connection.
® When you terminate a connection, no dialog is
displayed on the disconnected user’s Remote Utility.

( lcom Remote Utility — X

@ cli

N =~

settings Cannect: D\smnnactl @ Click J Manitar Delete

Remote Utility

The radio is in use by a remote PC. Do you want to disconnect?

_ @ Click
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Connect to the Base station transceiver.
(p. 2-11, p. 3-14, p. 4-15)

About the Remote mode Open the Connect Setting screen.
(p. 6-2) (p. 2-11, p. 3-14, p. 4-15)

B R|-BA1 Remol|e Control
File [View Opilon Help

|
|
g " - o

Memory

WARE RS-BA1  pann FILTER

SFT. 0] 18 FILTER FILTER
P.AME 1 % MAIN — TWIN-PET — SUB
1 TUNER 3. —_—

TUNE R-1.2k R-15k 7 6
=1 FILZ| [ TSk FILT| [ TSk
ANT 33 (RUSE (Fil2 [USB | = ¥ PET-CLR ¥ PET-CLR

14.100.26 - van—rorci—sin
: 1:—BL ‘,- . '] N
| BK-IN m 1 ; \-_

[ |
AT . ] _ 1 NOTCH
I APF

I TPF
TEW WIDE ¥ DIGI-SEL ¥ DIGISEL
MODE
RTTY PSK AM GENE § TONE
B DUAL-W B SPLIT 5 sUB

MEMORY GHPREE
MPW MP-R
CW PITEH g MEMO GROUP
7 .\ | | | A v A
( ) = > UF DOWN UP

MR

To use transmit audio input from the PC (p. 6-2)

TIP: See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function. To display the Help file, click “Contents” in the Help menu on the
Remote Controller application, or push the [F1] key on your PC’s keyboard.

The windows that are displayed by right-clicking on each button on the Remote Controller, see the Operating
Guide at the end of this manual.
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To use transmit audio input

from the PC

In order to use the transmit audio input from the PC
function when remotely controlling the transceiver
using the Remote Controller, configure the following
settings, according to the connection between the
transceiver and the Server PC.

If you operate from the Remote PC, confirm the
transceiver is connected to the Server PC.

1. Connect to a transceiver with the Remote
Controller.

2. Click <MIC SET> to open the MIC SET screen.

3. Select an appropriate connector in MOD Select
(Remote ON), to input transmit audio from the PC
to the transceiver.
® The options differ, depending on the transceiver

selected in Model on the Connect Setting screen.

4. Right-click <MOD LEVEL> to rotate clockwise, or
left-click it to rotate counterclockwise, to adjust the
input level from the connector.

5. Click < = > to close the screen.

MIC SET * || ® Click
MOD Select
[Remote OM] ® Select
-
MOD LEVEL
O @ Adjust

6-2

About the Remote mode

When connected to the transceiver, the Remote
Controller automatically turns ON the Remote mode.
While the Remote mode is ON, the Remote Controller
transmits CIl-V commands not only to check the
transceiver’s current state, but also to remotely control
it.

When you want the Remote Controller to only check
the transceiver’s current state, or when you want

to inhibit the Remote Controller from transmitting
control commands while you manually operate the
transceiver, turn OFF the Remote mode.

To turn OFF the Remote mode
Click the Remote icon in the toolbar, or click
“‘Remote OFF” in the File menu.

To turn ON the Remote mode
Click the Remote icon in the toolbar, or click
“Remote ON” in the File menu.

® You can select the desired connector(s) for
transmitting audio input when the Remote mode
is OFF. See the Remote Controller’s Help file for
“Remote Setting” details.

NOTE: DO NOT allow the PC to go into the sleep or
standby mode while using the RS-BA1. Otherwise, it
might not work properly after the PC resumes normal
activity.
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Using the RC-28

If you connect the optional RC-28 REMOTE ENCODER
to your PC, you can use the RS-BA1 and feel like you
are operating the actual transceiver’s MAIN dial.

1. Connect the RC-28 to the PC that has RS-BA1
installed.
® When you connect the RC-28 to the PC for the
first time, wait until “Device driver software installed
successfully.” is displayed.

NOTE: DO NOT connect the RC-28 to the PC with
other than the supplied USB cable, or through any
USB hub. The RC-28 may not work properly.

—— [LINK] indicator

* The [LINK] indicator on the RC-28 lights green.
* Now you can control the assigned functions of the RS-
BA1 using the RC-28.

TIP: If the [LINK] indicator does not light, check the

following.

1. Click “USB Dial...” in the Option menu to open
the USB Dial Setting screen.

2. If Select Device is set to “Not Use,” set it to the
RC-28'’s serial number.
(Example: RC-28 02XXXXX)
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The following are possible causes and solutions for the problem you are experiencing.
If you cannot solve the problem after trying these solutions, please contact your nearest dealer or Icom Service
Center.

Problem: Cannot access a Server from a Remote PC with the Remote Utility
® You can configure the Server information on the Server Properties screen. (Server List screen = <Properties>)

“Connection Failed” is displayed under the Server name

IC-7851 Possible cause 1

An incorrect IP address, domain name, or network name (Computer name) is entered
Connection to request a connection to the Server.
Failed @ If the Remote Utility cannot get the Server’s IP address using the domain name or

network name (Computer name) that you entered, “Cannot resolve the name” is
displayed next to the name.

Solution

1. Check the Server’s IP address, domain name, or network name (Computer
name). (pp. 3-2, 4-2)

2. Enter the Server’s correct IP address, domain name, or network name in Server
Address or Network Name on the Server Properties screen.

Possible cause 2
The control port number is different than that of the Server.

Solution

1. Check the Server’s control port number*. (pp. 2-2, 4-4)

2. Enter the correct port number into Control Port (UDP) on the Sever Properties
screen.
* The default number is “560001.”

Possible cause 3
The virtual driver is not installed in the Remote PC.

Solution
Install the virtual driver in the Remote PC.
(See the RS-BA1 PREPARATION for details.)

“Logon Failed” is displayed under the Server name

IC-7851 Possible cause
The user ID or password is different than the one in the Base station.
EFJI“; Solution
== 1. Confirm the Remote PC information registered in the Base station.
(pp- 3-2, 4-5)

2. Enter the correct user ID and password into User ID and Password on the Sever
Properties screen.

“Disabled” is displayed under the Server name

IC-7851 Possible cause
The Server is set to “Disable,” to inhibit connecting to it.
Disabled Solution

Enable the Server by removing a check mark from Disable on the Sever Properties
screen.
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NOTE: If you could not solve the problem after trying the solutions, check the following on the Base
station.

When connecting to the network directly:
* Is the transceiver turned ON or Remote standby mode?
* Is Network Control set to “ON"? (pp. 3-2, 4-5)

When connecting to the network through a PC:

* Is the Remote Utility activated?

* |s your Remote station information registered on the Remote Utility’s User List screen? (p. 5-4)
* |Is the Remote Utility added as an exception in the Firewall? (p. 1-1)

Problem: Cannot access a transceiver with the Remote Utility

The description in this part is based on the assumption that the connection to the Server has succeeded.
» “Connected” is displayed under the Server name when the connection is successful.

Possible cause
Another user is currently operating the transceiver.

Solution

Wait for “Busy” to disappear.

@ If you are operating as an administrator or a Server, you can terminate a
connection between another user and a transceiver. (p. 5-16)

is displayed under the radio name

Possible cause 1
The serial port number (default: 50002) or the audio port number (default: 50003) is
not connected.

Solution
Check the Firewall settings for the Remote PC.
When using the Internet, also check the router’s port forwarding settings. (p. 4-4)

Possible cause 2
Access to the selected transceiver is inhibited by the Server PC.

Solution
Allow the Remote PC to access the transceiver with the Server PC’s Remote Utility.

(p. 5-4)
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Possible cause 1
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.

Possible cause 2
Started the Remote Utility right after the PC has booted.

Solution
Wait for a while after the PC has booted, and then start the Remote Utility.

Possible cause 3
An audio device or COM port has been added to the PC, or removed from the PC.
For the USB device, the USB port number has been changed.

Solution
The COM port number or the audio device name may have been changed.
Reregister the radio on the Registered Radio List screen. (p. 5-2)

Possible cause 4
The audio or serial wiring is disconnected.

Solution

If you are using a USB serial conversion cable or a USB audio cable, make sure the
USB cabile is firmly connected.

Make sure the 3.5 (d) mm (1/8”) audio cable is firmly connected.

NOTE: If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* |s the transceiver turned ON or in the Remote standby mode?

When connecting to the network through a PC:

* |s the transceiver turned ON?

* Are the correct COM port number and audio device to which the transceiver is connected selected on
the Radio Properties screen?
(Option = Local/Server Settings = Registered Radio List screen = <Properties>)

* |s the Server PC not directly accessing the transceiver using the Remote Controller, without having
used the Remote Utility to connect to the transceiver?
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Problem: Cannot access a transceiver with the Remote Controller

® To access a transceiver with the Remote Controller, configure the connection settings on the Connect Setting
screen. Click < E > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen.

The description in this part is based on the assumption that the connection to the transceiver using the Remote

Utility has succeeded.

» “<<Connected>>" is displayed under the radio name when the connection is successful.
When connecting to the transceiver through the network using the Remote Utility

Possible cause 1

In CI-V of the Remote Controller’s Connect Setting screen, the CI-V settings are different than that in the
Remote Utility.

Solution

On the Connect Setting screen, click <Search>, and then select the correct transceiver in the Remote
Utility menu.

» The CI-V settings are automatically loaded from the Remote Utility.

Possible cause 2
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.

NOTE: If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* Is the transceiver turned ON or in the Remote standby mode?

When connecting to the network through a PC:

* Are the same CI-V address and baud rate that are programmed into the transceiver set on the Radio
Properties screen?

(Option = Local/Server Settings = Registered Radio List screen = <Properties>)

When directly accessing the transceiver without using the Remote Utility

Possible cause 1
An incorrect COM port number is set on the Remote Controller’s Connect Setting screen.

Solution
1. Check the COM port to which the transceiver is connected, on your PC’s Device Manager.
2. Set the correct COM port number to COM Port on the Remote Controller’s Connect Setting screen.

Possible cause 2
The CI-V address or baud rate is different than that are set into the transceiver.

Solution
1. Check the transceiver’s Cl-V address and baud rate.
® See the transceiver’s instruction manual for details.
2. Enter the transceiver’s correct Cl-V address in CI-V address (Radio), and select the transceiver’s
correct baud rate in Baud rate (bps), on the Remote Controller’s Connect Setting screen.
@ If the radio’s baud rate is set to “Auto,” select “19200” in the Baud rate (bps) menu.
@ If you are using the Spectrum Scope function with the IC-7851, IC-7850, IC-7610, or IC-7300 using a USB
for the connection, select “115200” in the Baud Rate menu.

Possible cause 3
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.
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Problem: The DUAL mode screen of the Remote Controller cannot be displayed

® To access a transceiver with the Remote Controller, configure the connection settings on the Connect Setting
screen. Click < a > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen.
Possible cause

An incorrect transceiver’s model is set on the Remote Controller’s Connect Setting screen.
Solution

Select a model named with “(DUAL).”

Problem: Cannot properly control the transceiver with the Remote Controller
Possible cause
The same CI-V address is being used by other control software.
Solution

Select an address other than “EQ” in CI-V Address (RS-BA1) on the Remote Controller’s Connect
Setting screen. However, this solution does not always solve the problem.

NOTE:

If you could not solve the problem after trying the solutions, check the following.
* Are there any radios that have the same CI-V address in the system?
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Problem: The received audio cannot be heard.

The description in this part is based on the assumption that the connection to the transceiver has succeeded.
» “<<Connected>>" is displayed under the radio name when the connection is successful.

Possible cause 1
The speaker is not turned ON, or the volume level is too low.

Solution
Turn ON the speaker, or adjust the volume level.

Possible cause 2
An earphone or other device is connected to the computer in place of the speaker.

Solution
Disconnect the device.

Possible cause 3
The appropriate audio device is not selected in the Remote Utility.

Solution

Select the appropriate audio device in Speaker on the Connection Setting screen.

(Radio List screen = <Settings>) (pp. 3-12, 4-13)

® If you connect a new USB audio device to your PC, the audio device which is selected as a default
device in your PC can be changed. If you select “Default Device” in Speaker, keep that in mind.

Possible cause 4
The volume level of the audio device is set to too low on your PC.

Solution

Adjust the volume level of the audio device. (p. 1-3)

® The PC has the Volume Mixer function that can adjust each application’s audio level. Confirm that the
Remote Utility or the control software is not muted, or set it to an appropriate volume level.

Possible cause 5
Audio output is disabled in the Remote Utility.

Solution
Insert a check mark in AF Transmission on the Connection Setting screen.
(Radio List screen = <Settings>)

Possible cause 6
The volume level is too low, or the mute is turned ON in the Remote Utility.

Solution
Adjust the volume level on the Received Audio Adjustment screen.
(Radio List screen = <AF>) (p. 5-12)

NOTE:
If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* Is Network AF set to an appropriate level in the Others set mode?

When connecting to the network through a PC:

* Is the volume level of the audio device that the transceiver is connected to set to an appropriate
level?
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Problem: The received audio cannot be heard in the DUAL mode.

® See also “Problem: The received audio cannot be heard.”

Possible cause 1
The codec setting for the received audio is set to 1 channel on the Remote Utility’s Settings screen.

Solution
Set the codec setting for the received audio to 2 channels.

Possible cause 2
When the transceiver is connected to the PC with a USB cable, the audio device setting is incorrect.

Solution
Set the microphone’s Default Format to 2 channels on the Windows Sound setting screen.
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Problem: The transmit audio cannot be output.

The description in this part is based on the assumption that the connection to the transceiver has succeeded.

» “<<Connected>>" is displayed under the radio name when the connection is successful.

® To check the Remote PC’s transmit IF signals, use the Transmit Monitor function with the Server PC’s Remote
Utility, or place a receiver near the Remote PC or Server PC.

Possible cause 1
The microphone is not turned ON, or the input level is too low.

Solution
Turn ON the microphone, or adjust the input level.

Possible cause 2
The appropriate audio device is not selected in the Remote Utility.

Solution

Select the appropriate audio device in Mic on the Connection Setting screen.

(Radio List screen = <Settings>) (p. 5-10)

® If you connect a new USB audio device to your PC, the audio device which is selected as a default
device in your PC can be changed. If you select “Default Device” in Mic, keep that in mind.

Possible cause 3
The input level of the audio device is set to too low on your PC.

Solution
Adjust the input level of the audio device. (p. 1-3)

Possible cause 4
Audio input is disabled in the Remote Utility.

Solution
Insert a check mark in MOD Transmission on the Connection Setting screen.
(Radio List screen = <Settings>)

Possible cause 5
The input level is too low in the Remote Utility.

Solution
Adjust the input level on the Transmit Audio Adjustment screen.
(Radio List screen = <MOD>) (p. 5-12)

Possible cause 6
An incorrect connector is selected in the Remote Controller.

Solution
Select the proper transceiver’s connector which is connected to the Server PC, in MOD Select (Remote
ON) on the Remote Controller’s MIC SET screen. (p. 6-2)

NOTE:
If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* Is Network AF set to an appropriate level in the Others set mode?

When connecting to the network through a PC:

* Is the volume level of the audio device that the transceiver is connected to set to an appropriate
level?

7-8



7

TROUBLESHOOTING

Problem: The received audio is intermittent

Possible cause 1
The network data transfer is excessive.

Solution

Select a lower sampling rate value in Sample Rates, or a different codec in Codecs, on the Connect

Settings screen. (Radio List screen = <Settings>)

@ First, select the lowest value. If the received audio is not interrupted with the setting, try a higher
value, and adjust to an appropriate value.

Possible cause 2
The capacity of the prebuffer is not enough.

Solution

Select a longer value in Prebuffer (ms) on the Connection Setting screen.

(Radio List screen = <Settings>)

® Select as short a value as possible, because longer prebuffers can cause a delay, and make it difficult
to adjust the audio level.

Possible cause 3
Your PC is overloaded.

Solution 1
Shutdown other applications, if running.

Solution 2
Reduce the number of transceivers you are accessing with the Remote Utility.

NOTE:

* If you are accessing the transceiver through a network, removing a check mark from Retransmission
on the Connection Setting screen can solve the problem.
(Radio List screen = <Settings>)

* You can check the simplified packet round trip time, and the average packet loss on the Remote
Utility’s Server List screen.

IC-7851

Connected

Packet round trip time Average packet loss

Problem: The connect settings cannot be changed

IC-7851abc Possible cause 1

The transceiver is “Offline.”

Offline

— Solution

Click <Connect> on the Server List screen to connect to the server.

IC-7851abe Possible cause 2

“<<Connected>>" is displayed.
<< Connected >>| .
Solution

Click <Disconnect> on the Radio List screen to disconnect from the transceiver.
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Problem: The connect settings cannot be changed using the Remote Controller

Possible cause
The Remote Controller is connected to the transceiver.

Solution
Click < f@)l > to disconnect it from the transceiver.
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Remote Controller Operating Guide (DUAL mode screen) TIP:

* You can select either “Knob” or “Slider” on the Set Mode screen to adjust each setting.
The following windows are displayed by right-clicking on each button on the Remote Controller. (Set Mode > Controllers > Control Type) ) g

® There are some windows that are displayed by left-clicking. The buttons are marked in white. - Some windows are not displayed, depending on the connected transceiver.
(Example: Memory Channel Editor).

® The windows whose title are with “(MAIN)” are displayed when you select the MAIN band.
When you select the SUB band, “(SUB)” is displayed instead.
® The windows that are displayed by right-clicking can also be displayed by right-clicking on the screen icons.
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Remote Controller Operating Guide (Single mode screen) TIP:

. . . . . * You can select either “Knob” or “Slider” on the Set Mode screen to adjust each settings.
The following windows are displayed by right-clicking on each button on the Remote Controller. (Set Mode > Controllers > Control Type)

® There are some windows that are displayed by left-clicking. The buttons are marked in white. - Some windows are not displayed, depending on the connected transceiver.
(Example: Memory Channel Editor).
® The windows that are displayed by right-clicking can also be displayed by right-clicking on the screen icons.
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